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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2002 – 2005, 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP software support web site at:

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 
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1 Introduction to HP Operations Smart Plug-ins
HP Operations Smart Plug-ins (SPIs) work in conjunction with HP Operations Manager 
(HPOM) to help you monitor, detect, solve, and prevent problems in your enterprise IT 
environment. The combination of HPOM and SPIs enables you to simplify the following tasks 
in your IT resource:

• Monitoring availability and health

• Detecting performance lapse

• Detecting, preventing, and solving problems

• Documenting problem solutions

• Generating reports

HPOM is a distributed client-server software. The central server, on which HPOM is installed, 
is called the management server. HPOM monitors systems in the network where your 
enterprise IT applications and resources are installed. These systems, which are monitored by 
HPOM, are called managed nodes. The HP Operations agent, residing on every managed 
node, facilitates communication between the management server and the managed node.

A SPI is software that provides management capabilities to HPOM specific to a particular 
enterprise application. You must install a SPI on the management server.
9



Figure 1 HPOM Client-Server Architecture

Smart Plug-in for Microsoft Exchange Server

The Smart Plug-in for Microsoft Exchange Server (the Microsoft Exchange SPI) enables  
HPOM to monitor Microsoft Exchange Server 2007, 2003, and 2000. The Microsoft Exchange 
SPI enables you to monitor and manage your enterprise Exchange environment through 
predefined policies, which you can customize. These policies help you monitor server load, 
server performance, client availability, message delivery times, and service level objectives.

After you set up the Microsoft Exchange SPI, you can view critical information about your 
Microsoft Exchange Server through the HPOM console in the form of:

• Message alerts

• Map view

• Reports and graphs

• Topology viewer
10 Chapter 1



 Message Alerts

The Microsoft Exchange SPI monitors events and services on the managed nodes (servers on 
which the Microsoft Exchange Server is installed and the HP Operations agent is deployed) 
and generates messages, which are displayed on the message browser of HPOM console. 

Figure 2 Message Alerts on HPOM Console

 Map View

The map view of HPOM presents a graphical and structural view of your Microsoft Exchange 
Server environment. The Microsoft Exchange SPI discovers Exchange nodes and Exchange 
environment services and displays them in the map view. The map view displays the real-time 
status of your Exchange environment.
Introduction to HP Operations Smart Plug-ins 11



Figure 3 Map View on HPOM Console

The map view indicates severity levels problems in the Exchange organization with the help 
of colors  (red, yellow, blue, and green).

 Reports and Graphs

You can integrate the Microsoft Exchange SPI with HP Reporter and HP Performance 
Manager to generate reports and graphs based on collected metric data. HP Reporter captures 
and formats data collected at nodes and generates web based reports. HP Performance 
Manager generates graphs from near real-time data gathered from the managed nodes. You 
can access these graphs from the HPOM console if you install HP Performance Manager on 
HPOM management server.

 Topology Viewer

The Microsoft Exchange SPI enables you to view an Exchange organization graphically with 
the help of three-dimensional maps of routing groups and server connections. From the 
topology view you can quickly view routing groups, Exchange servers, and the roles they play 
within your Exchange organization.
12 Chapter 1



Figure 4 Topology Viewer
Introduction to HP Operations Smart Plug-ins 13
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2 Installing the Microsoft Exchange SPI
The Microsoft Exchange SPI is packaged with the HP Operations Smart Plug-ins  DVD. You 
must install the Microsoft Exchange SPI on the HPOM management server. The installation 
wizard guides you through the entire process of SPI installation.

Installation Prerequisite

If you plan to use the Microsoft Exchange SPI with HPOM for Windows 8.00, skip this 
procedure and go to the Installation Procedure section. 

If you plan to use the Microsoft Exchange SPI with OVO for Windows 7.50, follow these steps:

1 Go to the following web site:

http://www.hp.com/go/hpsoftwaresupport

The HP Software Support Online page opens.

2 On this page, click Software patches under the Where do I find section.

3 Log on using the HP Passport credentials.

4 Download the patch OVOW_00254 and install on the management server (OVO for 
Windows 7.50). This patch installs the HP Operations agent version 7.35 on the 
management server.

You can search the patch with the OVOW_00254 keyword in the search text box.
  15



Installation Procedure

To install the Microsoft Exchange SPI on the management server, follow these steps:

1 Insert the HP Operations Smart Plug-ins  DVD into the DVD-ROM drive of the 
management server. The installation wizard opens.

2 Click Next. The Smart Plug-in Release Notes and Other Documentation screen appears.
16 Chapter 2



3 Click Next. The Product Selection screen appears.
Installing the Microsoft Exchange SPI 17



4 Select Microsoft Exchange Server, and then click Next. The Enable/Disable 
AutoDeployment screen appears. 

5 Select an option (Enable or Disable), and then click Next. The License Agreement screen 
appears.
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6 Select the I accept the terms...option, and then click Next. The Ready to Install the 
Program screen appears.

7 Click Install. The installation begins

8 The wizard installs the core SPIs, all necessary packages, and the Microsoft Exchange 
SPI. After the installation is complete, click Finish.

Removing the Microsoft Exchange SPI

Perform the following tasks to remove the Microsoft Exchange SPI from the management 
server and the Microsoft Exchange SPI policies from the managed nodes:

Task 1: Remove Policies from the Managed Nodes

1 In the HPOM console tree, expand the folders Operations Manager → Policy Management → 
Policy groups → SPI for Exchange.

2 Right-click SPI for Exchange, and then select All Tasks → Uninstall from...

3 In the Uninstall Policies on dialog box, select All Nodes.

4 Click OK.

Task 2: Delete Microsoft Exchange SPI Policy Groups from the Management Server

1 In the console tree of the HPOM console, select and expand the folder Policy Groups.

2 Right-click SPI for Exchange, and then select Delete.

Check if there are any customized policies on the nodes and remove those.
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Task 3: Delete Microsoft Exchange SPI Tools from the Management Server

1 In the console tree of the HPOM console, right-click Tools, and then select Configure → 
Tools.

2 In the Configure Tools dialog box, right-click SPI for Exchange, and then select Delete.

Task 4: Delete Microsoft Exchange SPI Customized Policies from the Management Server

1 Navigate to Polices grouped by type.

2 For each Policy type group, right-click the group, and then select Set Filter....

3 Select the All versions of the policy below option, and then click OK.

4 Sort policies by name in the list box. Select all Microsoft Exchange SPI policies.

5 Right-click and select All tasks → Delete from server.

6 Repeat for all policy groups.

Task 5: Remove the Microsoft Exchange SPI from the Management Server

1 From the Start menu, click Settings → Control Panel. The Control Panel window opens.

2 Double-click Add or Remove Programs. The Add or Remove Programs window opens.

3 Select HP Operations Smart Plug-ins  from the list of programs, and then click Change or 
Remove. The uninstallation wizard opens.

4 Click Next.

5 Select the Remove products option, and then click Next.

6 Select the SPI for Microsoft Exchange Server in the Product Selection screen.

7 Click Finish when uninstallation is complete.

Installing the Microsoft Exchange SPI in a Cluster Environment

Before you start installing the Microsoft Exchange SPI in a cluster environment, make sure 
that HPOM for Windows 8.00 or HP OpenView Operations (OVO) for Windows 7.50 is 
installed on each system of the cluster. 

If you are installing the Microsoft Exchange SPI on OVO for Windows 7.50, you must meet the 
prerequisite described in Installation Prerequisite on page 15.

To install the Microsoft Exchange SPI in an HPOM cluster, follow these steps:

1 Insert the HP Operations Smart Plug-ins  DVD into the DVD-ROM drive of the first node 
of the HPOM cluster. The installation wizard appears.

2 Follow the instructions in the wizard to install the SPI.

3 Repeat step 1 and step 2 on each node of the HPOM cluster.

The HPOM console does not function properly until you install the SPI on all nodes in the 
HPOM cluster.
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Removing the Microsoft Exchange SPI from a Cluster Environment

To remove the Microsoft Exchange SPI from a cluster HPOM/OVO environment, follow these 
steps:

1 Remove the Microsoft Exchange SPI policies from the managed nodes (see Task 1 on 
page 19).

2 Delete the Microsoft Exchange SPI policy groups from each management server of the 
cluster (see Task 2 on page 19).

3 Delete the Microsoft Exchange SPI tools from each management server of the cluster (see 
Task 3 on page 20).

4 Delete the Microsoft Exchange SPI customized policies from each management server of 
the cluster (see Task 4 on page 20).

5 From each management server, remove HP Operations Smart Plug-ins  from the Add or 
Remove Programs window, and then select Microsoft Exchange Server in the Product 
Selection Uninstall screen to remove the Microsoft Exchange SPI.

Alternatively, you can insert the HP Operations Smart Plug-ins  DVD into the DVD-ROM 
drive of each management server and remove the Microsoft Exchange SPI.

Upgrading the Microsoft Exchange SPI

If you have an older version of the Microsoft Exchange SPI installed in your environment, you 
need to perform certain tasks to ensure an effective and optimal upgrade. 

If you plan to upgrade the Microsoft Exchange SPI on OVO for Windows 7.50, make sure the 
prerequisite described in Installation Prerequisite on page 15 is met.

To upgrade to the latest version of the Microsoft Exchange SPI, follow these steps:

1 Identify the nodes on which you deployed earlier versions of the Microsoft Exchange SPI.

2 Right-click one of the identified nodes, and then click View → Policy Inventory. The details 
pane displays the list of deployed policies.

3 Select all policies in the details pane, right-click, and then click All Tasks → Disable.

4 Select all policies in the details pane, right-click, and then click All Tasks → Remove.

5 Repeat step 2 to step 4 for all nodes on which you deployed earlier versions of Microsoft 
Exchange SPI policies.

6 If you customized any of the policies, run the following commands on the management 
server:

ovpmutil cfg pol dnl C:\temp\ConfigDir /a 
ovpmutil cfg mdl dnl C:\temp\ConfigDir\model.mof 
ovpmutil cfg usr dnl C:\temp\ConfigDir\usroles.xml 

HPOM saves the existing policy definitions in C:\temp\ConfigDir\.

7 Install the SPI from the DVD by following the procedure described under Installation 
Procedure on page 16.

8 If you customized any of the policies, and made a backup of policies (step 6), run the 
following commands on the management server:
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ovpmutil cfg pol upl C:\temp\ConfigDir\config.mm 
ovpmutil cfg mdl upl C:\temp\ConfigDir\model.mm
ovpmutil cfg usr upl C:\temp\ConfigDir\usroles.mm 

HPOM retrieves all the policy information that you backed up in step 6.

If you are using the Microsoft Exchange SPI with OVO for Windows 7.50, make sure the 
following requirements are met:

• The patch OVOW_00254 is already installed on the management server (see Installation 
Prerequisite on page 15). 

• The HP Operations agent version 7.35 is installed on the nodes that were being managed 
by the Microsoft Exchange SPI before the upgrade. You can install the agent manually or 
from the OVO console.

• If you manually install the HP Operations agent version 7.35 on a node, run the 
vcredist_x86.exe file from the %OvAgentDir% location on the node.

If you upgrade the Microsoft Exchange SPI from an older version, and then remove the SPI 
by using the wizard, the older versions of the Microsoft Exchange SPI policies are not 
automatically removed from the management server. You can remove those policies manually.
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3 Configuring the Microsoft Exchange SPI
After you install the Microsoft Exchange SPI, you must add nodes on which Exchange servers 
reside to the management console. Also, you must deploy necessary policies and perform 
certain configuration tasks on the added managed nodes to begin the monitoring operation.

Configuring the Microsoft Exchange SPI for Microsoft Exchange 
Server 2007

The Microsoft Exchange SPI will start monitoring a Microsoft Exchange Server 2007 node 
after you install the agent and deploy necessary policies on it. When you add a node, agents 
are automatically installed on the managed nodes.

Add Nodes

You can install the Microsoft Exchange SPI (version 11.30) on HPOM for Windows 8.00 or 
OVO for Windows 7.50. You can use this SPI with either HPOM 8.00 or OVO 7.50, depending 
on your requirement. To add a node on HPOM Console (for HPOM for Windows 8.00) or OVO 
Console (for OVO for Windows 7.50), perform the following configuration tasks:
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HPOM Console (for HPOM for Windows 8.00)

1 In the console tree of the HPOM console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.

2 In the left frame, expand discovered node groups, and then drag and drop a system to the 
right frame. In the right pane, right-click the newly added node, and then click Properties. 
The Node Properties dialog box opens. You can change the default node settings in this 
dialog box.

Alternatively, follow these steps:
24 Chapter 3



a In the right frame, right-click, and then click New Node. The Base Settings dialog box 
opens.

b In the Full Qualified Domain Name text box, type the full qualified domain name of 
the Microsoft Exchange Server node that you want to add.

c In the Display Name text box, type a name of the node that will be displayed in the 
HPOM console.
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d Click Next. The OS Setup screen appears.
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e Operating system details are automatically set in the OS Setup screen (If these are 
not automatically discovered, you must manually set these details). Click Next. The 
Advanced Settings screen appears.

f Click Finish.

3 If you want to change the default agent communication mode, follow these steps:

For detailed information on node properties, refer to the Configuring Managed 
Nodes section of the HP Operations Manager online help.
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a In the right frame, right-click a node, and then click Properties. The Node Properties 
dialog box opens.

b In the System tab, change the agent communication mode from the Agent Comm Type 
drop-down list.

c Click Apply, and then click OK.

4 Click Apply.

5 Click OK. The Agent Installation window opens. 
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6 In the Agent Installation window, select the Deploy check box to deploy agent. The 
Credentials Dialog dialog box opens.

7 Type username and password of a user who has permission to install software on the 
node.

8 Click OK.

When you add a node, the agent software is automatically installed on the node. If you 
manually install the DCE agent on a node, you must run the vcredist_x86.exe file from 
the %OvAgentDir% location on the node.

For detailed information, refer to the Remote agent installation section of the 
Configuring Agents chapter of the HPOM online help.
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OVO Console (for OVO for Windows 7.50)

1 In the console tree of the OVO console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.

2 Drag and drop a system from the left frame to the right frame.

3 Click Apply.

4 Click OK.

When you add a node, the agent software is automatically installed on the node. If you 
manually install the DCE agent on a node, you must run the vcredist_x86.exe file from 
the %OvAgentDir% location on the node.

After adding nodes, you must run the discovery policy on the newly added nodes (See Deploy 
the Discovery Policy on page 31).
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Deploy Instrumentation

To deploy instrumentation on the newly added nodes, follow these steps:

1 In the console tree of the HPOM/OVO console, right-click on a node, and then select All 
Tasks → Deploy Instrumentation. The Deploy Instrumentation dialog box opens.

2 Select SPI for Exchange 2007, and then click OK.

3 Similarly, deploy the SPI Data Collector instrumentation group. 

4 Perform step 1 and step 3 for all added nodes.

Deploy the Discovery Policy

To discover the Exchange environment on the managed nodes, you must deploy the discovery 
policy. If you want to monitor Microsoft Exchange Server clusters, you must provide the access 
credentials of a Microsoft Exchange Server 2007 administrator. Perform the following tasks to 
deploy the discovery policy on the managed nodes:

Task 1: Provide User Credentials

If you do not use Exchange server clusters, you can skip this task and deploy the discovery 
policy (see Deploy on Nodes on page 32). To provide the credentials of an administrative user 
to the Exchange 2007 Discovery policy, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Policy Management → Policy Groups  
→ SPI for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click 
Discovery.
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2 In the details pane, double-click Exchange 2007 Discovery. The Exchange 2007 Discovery* 
[11.10] (Service Auto-Discovery) dialog box opens.

3 In the User Editable Parameters pane, type the following information:

• In the User field, type user name of a user with administrative privilege along with 
the domain in the following format:

<Domain>/<User Name>

• In the Password field, type the password of the user.

• Retype the password in the Confirm Password field.

4 Close the Exchange 2007 Discovery* [11.10] (Service Auto-Discovery) dialog box.

Task 2: Deploy on Nodes

To deploy the Exchange 2007 Discovery policy on managed Exchange nodes, follow these 
steps:

1 In the console tree of the HPOM/OVO console, expand Policy Management → Policy Groups  
→ SPI for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click 
Discovery.

2 In the details pane, deploy the Exchange 2007 Discovery policy on the managed Microsoft 
Exchange Server 2007 nodes.
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Create Databases

After deploying the discovery policy, you must create databases on a data store. The Create 
Data Sources tool can create databases either on the HP Operations agent’s data store 
(embedded performance component — also known as CODA), or on HP Performance Agent. If 
you do not have HP Performance Agent installed in your environment, it creates databases on 
CODA. If you do not run this tool and create databases, the agent cannot log messages on the 
managed node. To run this tool, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.

2 In the details pane, double-click Create Data Sources. The Select where to launch this tool 
dialog box opens.
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3 Select the nodes on which you want to run the tool, and then click Launch. After a few 
seconds, the Tool Status window opens.

4 Click Close.

Run the Register DataCollector Tool

This tool registers COM components on the managed Exchange 2007 nodes. To run the 
Register DataCollector Tool, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.
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2 In the details pane, double-click Register DataCollector. The Select where to launch this tool 
dialog box opens.

3 Select the nodes, and then click Launch. After a few seconds, the Tool Status window 
opens.

4 Click Close.

Run the Start ExData Collection Manager Tool

To facilitate the data collection mechanism on managed nodes, the SPI for Microsoft Exchange 
Server 2007 uses collection manager, which is a background process that runs on managed 
Exchange 2007 nodes. Before you start using the SPI, you must run the Start ExData 
Collection Manager tool on managed Exchange 2007 nodes to enable data collection. To run 
the Start ExData Collection Manager tool on Exchange 2007 nodes, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.
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2 In the details pane, double-click Start ExData Collection Manager. The Select where to 
launch this tool dialog box opens.

3 Select the nodes on which you want to run the tool, and then click Launch. After a few 
seconds, the Tool Status window opens.

4 Click Close.

Run the Start PowerShell Collector Tool

The SPI for Microsoft Exchange Server 2007 uses PowerShell commands to collect metric 
values. PowerShell collector is a background process, that runs on managed nodes, and works 
in conjunction with collection manager to facilitate data collection. To run the Start 
PowerShell Collector tool on Exchange 2007 nodes, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Tools → SPI for Exchange, and then 
double-click Exchange 2007.
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2 In the details pane, right-click Start PowerShell Collector, and then click Properties. The 
Start PowerShell Collector Properties dialog box opens.

3 Go to the Target tab.
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4 Clear the Run As Agent User Option.

5 In the User Name text box, type a user name with the Exchange View Only 
administrative privilege.

6 In the Password and Verify Password text boxes, type the password for the above user.

7 Click Apply.

8 Click OK.

9 In the details pane, double-click Start PowerShell Collector. The Select where to launch this 
tool dialog box opens.

10 Select the nodes on which you ran the Start Collection Manager tool, and then click 
Launch. After a few seconds, the Tool Status window opens.

11 Click Close.

Deploy the EXSPI 8.X Refresh Collection Definition Policy

The PowerShell collection configuration utility enables you to modify the default collection 
definition by modifying the SPIMetaData.xml file. Every time you modify the 
SPIMetaData.xml file, you must deploy the EXSPI-8.X SPIMetaData Versioning policy on 
nodes for the modifications to take effect. However, the collection manager process starts 
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following the updated collection mechanism only after you deploy the EXSPI 8.X Refresh 
Collection Policy. To deploy the EXSPI 8.X Refresh Collection Definition policy, follow these 
steps:

1 In the console tree of the HPOM/OVO console, expand Policy Management → Policy groups 
→ SPI for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click 
Collector Definition.

2 In the details pane, right-click EXSPI 8.X Refresh Collection Definition, and then click All 
Tasks → Deploy on. The Deploy policies on dialog box opens.

3 Keep all default settings and select nodes from the Managed nodes list.

4 Click OK.
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Deploy the EXSPI 8.X Check Collector Server Policy

The EXSPI 8.X Check Collector Server policy checks the status of the PowerShell collector 
process on managed nodes. You must deploy this policy to all added Microsoft Exchange 
Server 2007 nodes. To deploy the Check Collector Server policy on nodes, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Policy Management → Policy groups 
→ SPI for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click 
Collector Definition.

2 In the details pane, right-click EXSPI 8.X Check Collector Server, and then click All Tasks → 
Deploy on. The Deploy policies on dialog box opens.

3 Keep all default settings and select nodes from the Managed nodes list.

4 Click OK.
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Deploy the EXSPI 8.X Check Collection Manager Policy

The EXSPI 8.X Check Collection Manager policy checks the status of the collection manager 
process on managed nodes. You must deploy this policy to all added Microsoft Exchange 
Server 2007 nodes. To deploy the Check Collection Manager policy on nodes, follow these 
steps:

1  the console tree of the HPOM/OVO console, expand Policy Management → Policy groups → 
SPI for Exchange → Exchange 2007 → Manual Deploy Groups, and then double-click Collector 
Definition.

2 In the details pane, right-click EXSPI 8.X Check Collection Manager, and then click All Tasks 
→ Deploy on. The Deploy policies on dialog box opens.

3 Keep all default settings and select nodes from the Managed nodes list.

4 Click OK.
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Redeploying the Instrumentation for the SPI for Microsoft 
Exchange Server 2007

After installing and configuring the Microsoft Exchange SPI, if you need to re-deploy the 
instrumentation on nodes, perform these tasks on all nodes in the given sequence:

1 Run the Stop ExData Collection Manager tool.

2 Run the Stop PowerShell Collector tool.

3 Re-deploy the instrumentation.

4 Run the Start ExData Collection Manager tool.

5 Run the Start PowerShell Collector tool.

Configuring the SPI for Microsoft Exchange Server 2003 and 
2000

If policy autodeployment is enabled on the management server, add the managed nodes 
according to the instructions in Add Nodes on page 42, deploy instrumentation on nodes 
according to the instructions in Deploy Instrumentation on page 49, and then start using the 
SPI.

If policy autodeployment is disabled on the management server, you must perform the 
following configuration tasks.

Add Nodes

You can install the Microsoft Exchange SPI (version 11.30) on HPOM for Windows 8.00 or 
OVO for Windows 7.50. You can use this SPI with either HPOM 8.00 or OVO 7.50, depending 
on your requirement. To add a node on HPOM Console or OVO Console, perform the following 
configuration tasks:
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HPOM Console

To add a new managed node in HPOM console, follow these steps:

1 In the console tree of the HPOM console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.

2 In the left frame, expand discovered node groups, and then drag and drop a system to the 
right frame. In the right pane, right-click the newly added node, and then click Properties. 
The Node Properties dialog box opens. You can change the default node settings in this 
dialog box.

Alternatively, follow these steps:
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a In the right frame, right-click, and then click New Node. The Base Settings dialog box 
opens.

b In the Full Qualified Domain Name text box, type the full qualified domain name of 
the Microsoft Exchange Server node that you want to add.

c In the Display Name text box, type a name of the node that will be displayed in the 
HPOM console.
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d Click Next. The OS Setup screen appears.
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e Operating system details are automatically set in the OS Setup screen (If these are 
not automatically discovered, you must manually set these details). Click Next. The 
Advanced Settings screen appears.

f Click Finish.

3 If you want to change the default agent communication mode, follow these steps:

For detailed information on node properties, refer to the Configuring Managed 
Nodes section of the HP Operations Manager online help.
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a In the right frame, right-click a node, and then click Properties. The Node Properties 
dialog box opens.

b In the System tab, change the agent communication mode from the Agent Comm Type 
drop-down list.

c Click Apply, and then click OK.

4 Click Apply.

5 Click OK. The Agent Installation window opens. 
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6 In the Agent Installation window, select the Deploy check box to deploy agent. The 
Credentials Dialog dialog box opens.

7 Enter details in the Credentials Dialog, and then click OK.

8 Click OK in the Agent Installation window.

When you add a node, the agent software is automatically installed on the node. If you 
manually install the DCE agent on a node, you must run the vcredist_x86.exe file from 
the %OvAgentDir% location on the node.

OVO Console

1 In the console tree of the OVO console, right-click Nodes, and then click Configure → 
Nodes. The Configure Managed Nodes window opens.

2 Drag and drop a system from the left frame to the right frame.
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3 Click Apply.

4 Click OK.

When you add a node, the agent software is automatically installed on the node. If you 
manually install the DCE agent on a node, you must run the vcredist_x86.exe file from 
the %OvAgentDir% location on the node.

Deploy Instrumentation

To deploy instrumentation on the newly added nodes, follow these steps:

1 In the console tree of the HPOM console, right-click on a node, and then select All Tasks → 
Deploy Instrumentation. The Deploy Instrumentation dialog box opens:

2 Select SPI for Exchange 200X, and then click OK. 

3 Similarly, deploy the SPI Data Collector instrumentation group.

4 Perform step 1 and step 3 for all the added nodes.

If the policy autodeployment is enabled, you can start using the SPI. 

If the policy autodeployment is disabled, you must run the discovery policy on newly added 
nodes (see Deploy Discovery Policy on page 50).
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Deploy Discovery Policy

For Microsoft Exchange Server 2003 or 2000, you must deploy the Discovery policy under 
Exchange 2003. To deploy this policy on managed nodes, follow these steps:

1 In the console tree of the HPOM/OVO console, expand Policy Management → Policy Groups  
→ SPI for Exchange → Exchange 2003 → ovo Exchange SPI core or Policy Management → 
Policy Groups  → SPI for Exchange → Exchange 2000 → ovo Exchange SPI core, and then click 
Discovery. 

2 In the right pane, deploy the EXSPI-6.X Exchange Service Discovery policy.

Create Databases

After deploying the discovery policy, you must create databases on a data store. The Data 
Collection policy can create databases either on the HP Operations agent’s data store 
(embedded performance component — also known as CODA), or on HP Performance Agent. If 
you do not have HP Performance Agent installed in your environment, it creates databases in 
CODA. If you do not launch this policy and create databases, agent cannot log messages on 
the managed node. 

To create databases in a data store, follow these steps:

1 In the console tree, expand Policy management → Policy groups → 
SPI for Exchange →  Exchange 2003 → Auto Deploy Groups → ovo Exchange SPI core or Policy 
management → Policy groups → 
SPI for Exchange →  Exchange 2000 → Auto Deploy Groups → ovo Exchange SPI core, and 
then click Data Collection.

2 In the details pane, deploy the EXSPI-6.X exspi Agent Configuration policy on the nodes 
of your choice.

Alternatively, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange →  Exchange 2000 and 2003, and then 
click EXSPI Utilities.

2 In the details pane, double-click Embedded Performance Component Configuration. The 
Select where to launch this tool dialog box opens.

3 Select the nodes, and then click Launch.

Configuring Data Stores

The Microsoft Exchange SPI collects metric data on managed nodes, and logs the data to a 
data store on managed nodes. By default, the SPI stores data in the embedded performance 
component (also known as CODA) of the HP Operations agent. If you have HP Performance 
Agent installed on the managed node, the SPI starts logging data in HP Performance Agent 
instead of the embedded performance component. If you want to switch back to the embedded 
performance component while HP Performance Agent is still installed on the node, you must 
perform additional configuration tasks on the managed nodes.

Task 1: Modify the Mechanism to Store Data

You must modify the mechanism to store data on the managed node. 
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For Microsoft Exchange Server 2007 nodes, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange, and then click Exchange 2007.

2 In the details pane, right-click Create Data Sources, and then click Properties. The Create 
Data Source Properties dialog box opens.

3 Go to the Details tab of the Create Data Source Properties dialog box.

4 In the Command text box, change 
"%OvAgentDir%\bin\instrumentation\exspidatasource.exe" -A -V -SPEC 
EX2007*.spec to 
"%OvAgentDir%\bin\instrumentation\exspidatasource.exe" -A -V -CODA 
-SPEC EX2007*.spec

5 Click Apply.

6 Click OK.

For Microsoft Exchange Server 2003 or 2000 nodes, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange→ Exchange 2000 and 2003, and then 
click EXSPI Utilities.

2 In the details pane, right-click Embedded Performance Component Configuration, and then 
click Properties. The Embedded Performance Component Configuration Properties dialog 
box opens.

3 Go to the Details tab of the Embedded Performance Component Configuration Properties 
dialog box.

4 In the Command text box, change 
"%OvAgentDir%\bin\instrumentation\exspidatasource.exe" -A -V -SPEC 
"%OvAgentDir%\bin\instrumentation\EXSPI*.spec" to 
"%OvAgentDir%\bin\instrumentation\exspidatasource.exe" -A -V -CODA 
-SPEC "%OvAgentDir%\bin\instrumentation\EXSPI*.spec"

5 Click Apply.

6 Click OK.

Task 2: Change the Data Store

After configuring the data source creation tools, follow these steps to change the data store on 
the managed node:

1 On the managed node, create a dsi2ddf folder in the location %OvAgentDir%\conf\.

2 Open a new text file by using a text editor. Save the text file as nocoda.opt in the 
location %OvAgentDir%\conf\dsi2ddf\ without adding any content to it. The SPI 
starts storing data back to the embedded performance component.
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4 Configuring Microsoft Exchange SPI for 
Message Delivery SLAs
The Microsoft Exchange SPI enables you to monitor message delivery performance of 
Exchange Server and compare the performance against Service Level Agreements (SLAs) of 
your organization. The SPI monitors message delivery and detects SLA violations by using 
end-to-end message ping.

Exchange Server 2007: Testing MAPI Connectivity

You can test the message delivery performance of Mailbox servers with the EXSPI-8.X Test 
Mapi Connectivity policy. You can test the MAPI connectivity latency and error by deploying 
this policy. The default MAPI connectivity latency is set at 10. If MAPI connectivity latency 
exceeds this threshold or if any error occurs during this test, the policy sends alert message to 
the message browser. You can change this MAPI connectivity latency threshold by using the 
PowerShell collection configuration utility.

To test the MAPI connectivity latency by setting a new threshold, perform these tasks:

Task 1: Change the Threshold Value 

1 Go to the PowerShell collection configuration utility.

2 In the left pane, expand Collection Components → OpCMsg Calls. 

3 In the left pane, click TestMapiLatency. 

4 In the right pane, click Delete to delete the existing threshold. 

5 Select TestMapiConnectivity from the MetricSetRef drop-down box. 

6 Select Latency from the MetricRef drop-down box. 

7 Select GreaterThanOrEQ from the Select Arithmetic Operator drop-down box. 

8 Set the threshold value in the value to compare box. 

9 Click Add. 

10 Click Apply Changes.

11 Click File  → Save.

Task 2: Identify Nodes

1 Identify the nodes on which you want to run the test.

2 In the left pane of the HPOM/OVO console, expand Policy management → Policy groups → 
SPI for Exchange → Exchange 2007 → Manual Deploy Groups, and then click Collector 
Definition.

3 In the details pane, right-click EXSPI-8.X SPIMetaData Versioning, and then click All Tasks → 
Update to latest.
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4 Deploy the EXSPI-8.X SPIMetaData Versioning policy on the selected nodes.

Task 3: Deploy the Policy 

Deploy the EXSPI-8.X Test Mapi Connectivity policy on the selected nodes to check if the 
latency is within the threshold value.

Exchange 2000/2003: Monitoring Message Delivery SLAs

Use the Exchange SPI End-to-End Message Ping to monitor message delivery SLAs. The 
End-to-End Message Ping procedure requires performing the following tasks in the order 
given.

Task 1: Create a New Source Mailbox for Each Source Server

A mailbox needs to be created on each managed Exchange 2000 or Exchange 2003 server from 
which the Ping messages will be sent out

1 In the HPOM/OVO console, expand the Tools → SPI for Exchange → Exchange 2000 and 2003 
→ End-to-End SLA Configuration folder.

2 In the details pane, double-click MBOX Config. The Select where to launch this tool dialog 
box opens.
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3 Select the nodes on which you want to launch the tool, and then click Launch. The Edit 
Logins and Parameters dialog box opens.

4 If you want to specify the organizational unit and mailbox prefix:

a Select the Parameters tab. By default, the organizational unit is set to Users, and the 
default mailbox prefix ID is msxspi, so the user/mailbox name will be msxspi<server 
name>. 

b Create the mailbox name with a prefix ID, followed by the Windows hostname, with 
no spaces: <prefix ID><server name>. For example, msxspi<server name>.

c Select the Login tab. Type the User name and password for a user who has the 
privilege to create Users with mailboxes in this domain.

d Click Launch.

Task 2: Run the End-to-End ConfigurationWizard to Configure SLAs

You must set message delivery SLAs of your organization by using the End-to-End 
Configuration tool.

1 In the console tree, expand the Tools → SPI for Exchange → Exchange 2000 and 2003 → 
End-to-End SLA Configuration folder.

2 In the details pane, double-click End-to-End Configuration.

3 Confirm the introductory dialog, which gives an example of a typical SLA by clicking Next.

4 Select the Microsoft Exchange SPI configuration setting that best matches your SLA, and 
then click Next.
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5 Select the Source Servers from the list of HPOM managed servers. A source server is a 
server from which an email is sent. 

6 Click Next.

7 Select the Destination Servers from the list. These can be any Exchange servers within 
your organization, not only HPOM managed Exchange servers. 

8 Click Next.

9 Specify the Service Level Agreement by assigning the thresholds (in seconds) for Timeout, 
Met SLA, and Almost met SLA. 

10 Click Next.

11 Confirm or make changes to the SLAs, and then click Next.

12 Select to deploy all End-to-End Policies to the managed nodes. Only managed nodes 
configured to determine SLAs will send and receive mail. 

 

13 Click Next.

14 Click Finish, and then click OK.

You can also perform this step manually by deploying SPI for Exchange 200X 
instrumentation and the EXSPI End-to-End Message Ping policy (Manual Deploy 
Groups → Exchange Server → Message Delivery folder) to any desired managed 
nodes.
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Figure 5 Example SLA thresholds, where Met SLA=60, Almost met SLA=60, Time 
Out=300

You must run the wizard whenever you add a new Exchange server as a managed node, if an 
SLA is to be monitored on the newly managed server.
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5 Microsoft Exchange SPI Clustering Support
You can use Microsoft Exchange Server 2007 and 2003/2000 in a cluster environment where 
the fail-over capability of Exchange Servers ensures uninterrupted Exchange availability. In 
the event of a cluster node failure, the Microsoft Exchange SPI automatically switches 
monitoring activity from the failed node to the active node.

Configuring Microsoft Exchange SPI for a Cluster Environment

The Microsoft Exchange SPI recognizes Exchange instances in an Exchange cluster by using 
XML configuration files (apminfo.xml and msexchange.apm.xml). In the event of failure, 
these XML files enable the HP Operations agent to automatically perform the following 
functions:

• Disable instance monitoring on the inactive node

• Enable instance monitoring on the currently active node

To configure the Microsoft Exchange SPI for a cluster environment, perform the following 
tasks in the order given. 

Task 1: Add the Exchange Cluster Nodes to HPOM Console

Identify the cluster nodes of your Exchange environment, and then add those nodes to HPOM 
console.

If policy autodeployment is disabled, you must launch the necessary policies on newly added 
cluster nodes.

The discovery policy discovers the Exchange cluster and updates the map with cluster 
topology. 

Task 2: Generate Cluster Application Configuration File

You must generate the apminfo.xml file to describe the cluster instances (Exchange virtual 
servers).

1 Launch the Exchange Cluster Configuration tool on the cluster nodes. 

2 For Exchange 2003 and 2000, in the console tree, expand Tools → SPI for Exchange → 
Exchange 2000 and 2003 → EXSPI Utilities.

For Exchange 2007, in the console tree, expand Tools → SPI for Exchange → Exchange 2007.
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3 In the details pane, double-click Exchange Cluster Configuration. The Select where to 
launch this tool dialog box opens.
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4 Click Launch. The Tool Status window appears and displays the output under the Tool 
Output section.

5 Select the text content under the Tool Output section, and then copy it to a text editor.

6 Save the text as apminfo.xml in the following location on cluster nodes:

— For DCE-managed nodes—%OvAgentDir%\conf\OpC\ 

— For HTTPS-managed nodes—%OvAgentDir%conf\conf\

7 Stop and start the agents on the nodes by using the following commands:

opcagt -kill
opcagt -start

Example apminfo.xml File

In the following example, ExchResGroup1 and ExchResGroup2 are the names of the Exchange 
resource groups corresponding to EXCHVIRTSERV1 and EXCHVIRTSERV2 instances (virtual 
servers):

<?xml version="1.0" ?>
<APMClusterConfiguration>
  <Application>
    <Name>msexchange</Name>
      <Instance>
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         <Name>EXCHVIRTSERV1</Name>
         <Package>ExchResGroup1</Package>
       </Instance>

<Instance>

<Name>EXCHVIRTSERV2</Name>
         <Package>ExchResGroup2</Package>
       </Instance>

  </Application>
</APMClusterConfiguration> 

Figure 6 Example of Exchange Resource Group   

Additional Configuration for Policy Name Change

The Microsoft Exchange SPI disables all policies from a cluster node if the node fails, and then 
enables all policies on the active cluster node. While switching its operation from disabled 
node to active node, the Microsoft Exchange SPI retrieves policy information from the 
msexchange.apm.xml file. If you change any policy name (or add a new policy) and deploy 
the changed policy on a managed cluster node, you must reflect the change in the 
msexchange.apm.xml file as well. To update the msexchange.apm.xml file with changed 
policy information, follow these steps:

1 On the management server, open the msexchange.apm.xml file from the following 
location by using a text editor:

— For DCE-managed nodes—%OvShareDir%\Instrumentation\Windows Server 
2003\5.2\SPI for Exchange\

— For HTTPS-managed 32-bit nodes—
%OvShareDir%\Instrumentation\Categories\SPI for 
Exchange\Windows\5.2\
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— For HTTPS-managed 64-bit nodes—
%OvShareDir%\Instrumentation\Categories\SPI for 
Exchange\Windows\5.2\X64

2 Edit the changed policy names in this file. Add new policy names (within Template 
markup), if required.

3 On the managed nodes, save the updated msexchange.apm.xml file in the following 
locations:

— For DCE-managed nodes—%OvAgentDir%\bin\instrumentation\

— For HTTPS-managed nodes—%OvAgentDir%bin\instrumentation\conf

4 Edit the changed policy names in this file. Add new policy names (within the Template 
markup), if required.

5 Restart the agent.

6 Redeploy the Microsoft Exchange SPI instrumentation on the node.

While redeploying the instrumentation on Microsoft Exchange Server 2007 nodes, refer to 
Redeploying the Instrumentation for the SPI for Microsoft Exchange Server 2007 on page 42.

Data Collection on Virtual Servers

The Microsoft Exchange SPI shows Exchange virtual servers in reports and graphs as though 
they were physical Exchange servers.You must deploy appropriate policies to a managed node 
to successfully show correct data for the node in reports and graphs. Follow the guidelines 
given below for deploying data collection policies on cluster nodes of Microsoft Exchange 
Server 2003/2000.

Microsoft Exchange Server 2003/2000

Run the Enable Message Tracking tool on all nodes in the cluster before deploying the EXSPI 
6.X Dc-TrackLog Data policy, so that the policy can generate tracking log reports. The tool 
must run on the physical nodes of a cluster where the Exchange virtual server is running.

Setting up End-to-End Message Ping on an Exchange Cluster

To configure End-to-End Message Ping in an Exchange 2003/2000 clusters, follow these steps:

1 Run the MBox Config tool on all nodes in the cluster. The tool must run on the physical 
nodes of a cluster where the Exchange virtual server is running. This is a necessary step 
for configuring and deploying End-to-End Message Ping. 

2 Run the End-to-End Configuration (wizard) tool to add the Exchange virtual server to the 
end-to-end configuration. Exchange virtual server names will appear in the Source Server 
and Destination Server fields. See Configuring Microsoft Exchange SPI for Message 
Delivery SLAs on page 53.

Map View for Exchange Cluster Services

The Microsoft Exchange SPI represents Exchange clusters in the map view. Map view creates 
one node for each virtual server in the cluster. Because the cluster is properly modeled in the 
service map, Microsoft Exchange SPI instrumentation and Quick Start policies are 
auto-deployed to all managed Exchange cluster nodes.
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Messages for the Exchange virtual server show up under the Exchange virtual server name in 
the maps.

For the Exchange Virtual server an EXSPI service discovery hosted-on hierarchy is created 
within a Clusters container. This allows messages to be sent to the hosted-on hierarchy. 

This same hierarchy is also created as virtual nodes under the Exchange Virtual Server. A 
dependency is created from each Virtual Exchange Server virtual node to its corresponding 
Cluster hosted-on node. Messages and status will then propagate to the correct Virtual 
Exchange Server virtual node.

Figure 7  Service Map Illustrating Clustering Support 

When a fail-over happens, dependencies to the failed node will be removed and replaced with 
new dependencies to the newly active node..

When a failover happens, messages that occurred before the failover will not be propagated to 
the virtual node

For this mechanism to work EXSPI-6.0 Exchange Cluster Discovery Event Log policy must be 
deployed (normally auto-deployed) for Exchange 2000 nodes.
64 Chapter 5



Microsoft Exchange SPI Clustering Support 65



66 Chapter 5



6 Additional Configuration for Microsoft 
Exchange Server 2007
The Microsoft Exchange SPI enables you to customize the monitoring activity on Microsoft 
Exchange Server 2007 nodes. By default, the collectors on Microsoft Exchange Server 2007 
nodes follow a pre-defined data collection mechanism. The SPI enables you to customize this 
definition to create new mechanisms to collect and store metric data. 

Data Collection Mechanism on Microsoft Exchange Server 2007

The default data collection mechanism on Microsoft Exchange Server 2007 is described in an 
XML file (spimetadata.xml). When you add a node for the first time, the default 
spimetadata.xml file is placed on the node. The collectors start collecting metric data 
according to this XML file. The Microsoft Exchange SPI provides you with a utility 
(PowerShell collection configuration utility) to modify the default mechanism of data 
collection on Microsoft Exchange Server 2007 nodes. The PowerShell collection configuration 
utility enables you to modify the spimetadata.xml file through its graphic user interface.

On a managed node, collectors collect metric data. If logging information is available, 
collectors log the collected data to a data store. Every collector follows a pre-defined 
mechanism to collect and log data, which is retrieved from the spimetadata.xml file. 

Collection is an element in the spimetadata.xml file that describes the complete data 
collection mechanism of a particular collector. Collection configuration consists of the 
following components or building blocks: 

• MetricSet — A metric is a measurement that defines a specific operational or 
performance characteristic of a system or an application. A MetricSet is a group of related 
metrics.

• OpCMsg Calls  — An OpCMsg Call is an element of a collection that generates an alert 
message when a metric value does not match a preset value or range of values.

• OpCMon Calls —  An OpCMon Call is an element of a collection that sends the collected 
metric data to a measurement threshold policy. The measurement threshold policy checks 
the data against some upper or lower threshold defined within the policy and sends alarm 
to the message browser.

• DataStore — A DataStore defines the way in which the collected data can be stored in 
the data store.

Collection Configurations

A collection configuration describes the complete workflow of a collector and defines the 
mechanism of metric data collection. It also defines how to store metric data. Every collection 
is associated with a scheduled task policy. When you invoke a scheduled task policy on a 
managed node, a collector retrieves the following information from a collection:

• The metric value to be collected 
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• The mechanism to send the collected data to analyzer for data analysis

• The mechanism to receive the analyzed data

• The mechanism to send the analyzed data to a DataStore (if required)

PowerShell Collection Configuration Utility

The Microsoft Exchange SPI provides you with a utility (PowerShell collection 
configuration utility) to modify the default mechanism of data collection on Microsoft 
Exchange Server 2007 nodes. The PowerShell collection configuration utility enables you to 
modify the spimetadata.xml file through its graphic user interface. You can change 
existing collection definitions, or create new collection definition to monitor additional metric 
data. It enables you to perform the following tasks:

• View existing collection configurations

• Modify existing collection configurations

• Add a new MetricSet

• Add an OpCMsg Call

• Add an OpCMon Call

• Add a DataStore

• Add a new collection configuration

Refer to the Smart Plug-in for Microsoft Exchange Server Online Help for information on the 
PowerShell collection configuration utility.

Adding or Modifying a Collection Configuration

To customize metric data collection mechanism on Microsoft Exchange Server 2007 nodes, you 
can modify an existing collection configuration present in the spimetadata.xml file, or you 
can add a new collection configuration. Using the PowerShell collection configuration utility, 
you can customize the configuration, and save the change in the spimetadata.xml file. After 
making the change, you must place this updated spimetadata.xml file on managed nodes 
by deploying the SPIMetaData Versioning policy the nodes.

Task 1: Run the PowerShell Collection Configuration Utility Tool

The PowerShell Collection Configuration Utility tool launches the PowerShell collection 
configuration utility interface. To run it, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange, and then click Exchange 2007.
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2 In the details pane, double-click PowerShell Collection Configuration Utility. The Select 
Server dialog box opens.

3 Select the OVO Windows Server option, and then click Load. The PowerShell collection 
configuration utility window opens.

Task 2: Add or Modify Elements of a Collection Configuration

You can modify the following components (building blocks) of a collection configuration or 
create new ones.

• MetricSet — Every default MetricSet corresponds to an Exchange PowerShell command 
(cmdlet). You can add additional MetricSets to the set of existing MetricSets and map 
those to available Exchange cmdlets. You can also add an available metric to a MetricSet.

• DataStore — You can modify the metric data logging mechanism by modifying an existing 
DataStore. The PowerShell collection configuration utility enables you to add new 
definitions of logging metric data by creating a new DataStore.

• OpCMsg Calls and OpCMon Calls  — OpCMsg Calls and OpCMon Calls describe the 
mechanism to trigger an error message when a metric value does not match with a preset 
value. Use the PowerShell collection configuration utility to modify OpCMsg Calls/
OpCMon Calls if you want to:

— Change default error messages

— Change preset value

— Change severity level of OpCMsg Calls/OpCMon Calls

Refer to the Smart Plug-in for Microsoft Exchange Server Online Help for detailed information 
on adding or modifying these components.

Task 3: Deploy the EXSPI-8.X SPIMetaData Versioning Policy on Nodes

After you make modifications in collection definitions, which are recorded in the 
spimetadata.xml file, you must deploy the file on the nodes of your interest. To achieve this, 
deploy the EXSPI-8.X SPIMetaData Versioning policy on the managed nodes on which you 
want to implement the modified data collection mechanism. 

While modifying default collection configurations or adding new collection configurations, if 
you change existing DataStores or add new DataStores, you must launch the Create Data 
Sources tool on the nodes on which you want the change to take effect. Launch the Create 
Data Source tool before you deploy the EXSPI-8.X SPIMetaData Versioning policy.
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To deploy the EXSPI-8.X SPIMetaData Versioning policy on managed nodes, follow these 
steps:

1 In the console tree, expand Policy groups → SPI for Exchange → Exchange 2007 → Manual 
Deploy Groups, and then click Collector Definition.

2 In the details pane, right-click EXSPI-8.X SPIMetaData Versioning, and then click All Tasks → 
Update to latest.

3 In the details pane, right-click EXSPI-8.X SPIMetaData Versioning, and then click All Tasks → 
Deploy on. The Deploy policies on dialog box opens.

4 Select the nodes on which you want to deploy the policy from the tree, and then click OK.

After you deploy the EXSPI-8.X SPIMetaData Versioning policy, the updated 
spimetadata.xml file is placed on the selected nodes. The Refresh Collector Definition 
policy updates the collection manager process with the modified collection mechanism 
described in the newly deployed spimetadata.xml file. 

The Refresh Collector Definition periodically runs on the node with an interval of 30 minutes. 
The new collection mechanism is not synchronized to the collection manager until the Refresh 
Collector Definition runs on the node. If you want the changes to take effect immediately after 
you deploy the SPIMetaData Versioning policy, launch the following tools in the given 
sequence on the nodes after deploying the SPIMetaData Versioning policy:

1 Stop ExData Collection Manager

2 Stop PowerShell Collector

3 Start PowerShell Collector

4 Start ExData Collection Manager

Using Additional Cmdlets

You can create customized cmdlets and use those cmdlets to monitor metric data on a 
managed node. You can create customized cmdlets to return additional metrics, and configure 
the SPI to monitor these additional metrics. Perform the following tasks to achieve this:

Task 1: Identify the Microsoft Exchange Server 2007 Node

Identify the Microsoft Exchange Server 2007 node on which you want to add customized 
cmdlets to observe additional metric data.

Task 2: Create Cmdlets

Create customized cmdlets on the identified nodes.

Task 3: Install Snap-ins

Install customized snap-ins for the newly created cmdlets on the nodes on which you have 
created new cmdlets.

Task 4: Update the Exspi-exshell.psc1 File

To update the Exspi-exshell.psc1  file with the new snap-in information, follow these 
steps:

1 Open the Exspi-exshell.psc1 file by using a text editor from the location 
%OvAgentDir%/bin/instrumentation.
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2 Add the following within the PSSnapin tag:

<PSSnapIn Name="new_snap-in_name" /> 
where new_snap-in_name is the name of newly added snap-in.

3 Save the file.

Task 5: Create New Collection Definitions for New Cmdlets

Use policy composer and create new collections with newly added cmdlets.

Task 6: Deploy the EXSPI-8.X SPIMetaData Versioning Policy on Nodes

Deploy the EXSPI-8.X SPIMetaData Versioning policy on the nodes on which you have 
created new cmdlets.
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7 Using Microsoft Exchange SPI Policies, Reports, 
and Graphs
Microsoft Exchange SPI policies enable you to simplify monitoring the performance and 
health of Microsoft Exchange Server. A policy contains a rule or a set of rules that automate 
the monitoring operation. The data collection mechanism of collectors on the managed nodes 
is governed by these policies. Policies can trigger alert signals in case of threshold violation. 
The SPI also enables you to generate reports and graphs to analyze metric data.

This chapter contains tables of Microsoft Exchange SPI policies, reports and graphs, and 
outlines procedures for: 

• Deploying the various policy groups

• Generating Microsoft Exchange SPI reports and graphs.

Using Microsoft Exchange SPI Policies

Microsoft Exchange SPI policies are classified in three broad groups — Exchange 2000, 
Exchange 2003, and Exchange 2007. Each group contains policies specific to a particular 
Microsoft Exchange Server version. Refer to the general information on Microsoft Exchange 
SPI policies listed below:

• Some policies in the SPI for Exchange policy groups require that particular software 
components or services be installed on Exchange server systems before the deployed 
policies will work.  

• Do not deploy Microsoft Exchange SPI policies on a non-Exchange systems.

• Regarding policy names:

— Policies for only Microsoft Exchange Server 2007 are prefixed with EXSPI-8.X

— Policies for only Microsoft Exchange Server 2003 are prefixed with EXSPI-6.5

— Policies for only Microsoft Exchange Server 2000 are prefixed with EXSPI-6.0 

— Policies for Microsoft Exchange Server version 2000 and 2003 are prefixed with 
EXSPI-6.X 

• You can use the ovpmwutil tool to update account information (user name and password) 
in multiple policies. Refer to the Server Command Line Utilities section in the 
HP Operations Manager for Windows Online Help.

Individual policy definitions are documented in the Microsoft Exchange SPI Online Help.

Policy Groups are located in the console tree under Policy Management → Policy Groups → SPI 
for Exchange and then the Exchange version.
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Figure 8 SPI for Exchange Policy Location on the Console Tree   
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Exchange 2007 Policies

The SPI for Microsoft Exchange Server 2007 does not provide any auto deploy policies. You 
must manually deploy the available policies depending on your requirement.

Exchange 2007 
Manual Deploy 
Groups Policies

Availability • EXSPI-8.X Exchange 2007 Application Errors
• EXSPI-8.X Exchange 2007 Application Warnings
• EXSPI-8.X Exchange 2007 Application Info

Client Access 
Server

• Availability
— EXSPI-8.X Monitor Client Access Server Services

• IMAP4
— EXSPI-8.X Monitor Check IMAP4 Max Connection
— EXSPI-8.X Dc-IMAP4 Performance
— EXSPI-8.X IMAP4 Failed Connection Rate
— EXSPI-8.X Monitor Check IMAP4 Max Connections from 

Single IP
— EXSPI-8.X IMAP4 Connections
— EXSPI-8.X Get IMAP4 Settings
— EXSPI-8.X Monitor Check IMAP4 Max Connections per User
— EXSPI-8.X IMAP4 Rejected Connection Rate

• Outlook Anywhere
— EXSPI-8.X Check Outlook Anywhere Enabled
— EXSPI-8.X Check Outlook Anywhere Not Enabled

• POP3
— EXSPI-8.X POP3 Failed Connection Rate
— EXSPI-8.X POP3 Connections
— EXSPI-8.X POP3 Rejected Connection Rate
— EXSPI-8.X Get POP3 Settings
— EXSPI-8.X Dc-POP3 Performance
— EXSPI-8.X Monitor Check POP3 Max Connections from 

Single IP
— EXSPI-8.X Monitor Check POP3 Max Connection
— EXSPI-8.X Monitor Check Pop3 Max Connections per User

Collector Definition • EXSPI-8.X SPIMetaData Versioning
• EXSPI-8.X Check Collector Server
• EXSPI-8.X Check Collection Manager
• EXSPI-8.X Refresh Collection Definition

Discovery Exchange 2007 Discovery
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Edge Server • EXSPI-8.X Edge Get Queue Data
• EXSPI-8.X Edge Check Tracking Log Settings
• EXSPI-8.X Edge Get Configuration of the Transport Agent
• Availability

— EXSPI-8.X Monitor Edge Server Services
• SMTP

— EXSPI-8.X Edge Dc-SMTP Performance for Inbound 
Connections

— EXSPI-8.X Edge Dc-SMTP Performance for Outbound 
Connections

ExBPA Integration • EXSPI-8.X Forward ExBPA Event Log Errors
• EXSPI-8.X ExBPA Integration

Hub Transport 
Server

• EXSPI-8.X Get Queue Data
• EXSPI-8.X Check Tracking Log Settings
• EXSPI-8.X Get Configuration of the Transport Agent
• Availability

— EXSPI-8.X Monitor Hub Transport Server Services
• SMTP

— EXSPI-8.X Edge Dc-SMTP Performance for Inbound 
Connections

— EXSPI-8.X Edge Dc-SMTP Performance for Outbound 
Connections

Exchange 2007 
Manual Deploy 
Groups Policies
76 Chapter 7



Mailbox Server • Availability
— EXSPI-8.X Monitor Mailbox Server Services

• High Availability
— Replication Monitoring

– EXSPI-8.X ReplicationCopyQueueLength

– EXSPI-8.X Replication Warnings in Application Event 
Log

– EXSPI-8.X Replication Errors in Application Event Log

– EXSPI-8.X Dc Replication Summary

– EXSPI-8.X ReplicationReplayQueueLength

– EXSPI-8.X Check Replication Service

• Mailbox
— EXSPI-8.X MailBoxItemCount
— EXSPI-8.X  IS Mailbox Average Delivery Time
— EXSPI-8.X  IS Mailbox Receive Queue Length
— EXSPI-8.X  Dc-IS Mailbox Performance
— EXSPI-8.X Check Circular Logging Enabled
— EXSPI-8.X Get Mailbox Details
— EXSPI-8.X Check If Circular Logging Disabled

• MAPI
— EXSPI-8.X Information Store RPC Operations
— EXSPI-8.X Test Mapi Connectivity
— EXSPI-8.X Information Store RPC Averaged Latency
— EXSPI-8.X Information Store RPC Requests

• Outlook Performance
— EXSPI-8.X Dc-Outlook Client
— EXSPI-8.X Outlook Client RPC Failure Rate
— EXSPI-8.X Outlook Client Latency

• Performance
— EXSPI-8.X Information Store Heap Memory Errors
— EXSPI-8.X Information Store VM Large Block Bytes
— EXSPI-8.X Information Store Db Log Record Stalls per sec
— EXSPI-8.X Information Store Performance
— EXSPI-8.X Information Store Additional Heaps
— EXSPI-8.X Information Store User Count
— EXSPI-8.X Information Store Db Cache Size
— EXSPI-8.X Information Store Db Log Threads Waiting
— EXSPI-8.X Information Store Memory Errors
— EXSPI-8.X Information Store VM Largest Block

Exchange 2007 
Manual Deploy 
Groups Policies
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Mailbox Server
(Cont.)

— EXSPI-8.X Information Store VM 16MB Blocks
— EXSPI-8.X Information Store Db Log Writes per sec

• Public Folder
— EXSPI-8.X  PublicFolderItemCount
— EXSPI-8.X  Public Replication Queue Length
— EXSPI-8.X  Get Public Folder Details
— EXSPI-8.X  IS Public Average Delivery Time
— EXSPI-8.X  IS Public  Receive Queue Length
— EXSPI-8.X  Dc-IS Public Folder Performance

Unified Messaging 
Server

— EXSPI-8.X GetUM IPGateway Details
— EXSPI-8.X Get UMHuntGroup Details 
— EXSPI-8.X Get UMMailbox Pin Details
— EXSPI-8.X Get UMMailbox Policy Details
— EXSPI-8.X Get UMServer Details
— EXSPI-8.X Get Unified Messaging Mailbox Details

• Availability
— EXSPI-8.X Monitor Unified Messaging Server Services

Exchange 2007 
Manual Deploy 
Groups Policies
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Exchange 2003/2000 Policies

Exchange 2003 Auto Deploy Policies

   

Exchange 2003 
Auto Deploy Groups Policies

Availability EXSPI-6.X Queue State
EXSPI-6.X Connector State
EXSPI-6.X Exchange System Errors
EXSPI-6.X Link State
EXSPI-6.X Exchange Services
EXSPI-6.X Process Monitor
EXSPI-6.X Exchange Application Errors
EXSPI-6.X Inactive Process Monitor
EXSPI-6.X Check CircularLogging Off 
EXSPI-6.X Check CircularLogging ON
EXSPI-6.X Check MailBox on Front-End
EXSPI-6.X Heap DeCommit Threshold
EXSPI-6.X Hotfix Installed 
EXSPI-6.X SSL for HTTPVS
EXSPI-6.X TransactionLog BackUp
EXSPI-6.X UrlScan State
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Client Accessibility ActiveSync
             EXSPI-6.5 ActiveSync AD Requests
             EXSPI-6.5 ActiveSync Mailbox Connection Requests
             EXSPI-6.5 ActiveSync Mailbox pending requests
             EXSPI-6.5 ActiveSync Users
             EXSPI-6.5 Dc-ActiveSync
             EXSPI-6.5 Dc-ActiveSyncNotify
OMA
             EXSPI-6.5 OMA Response time
             EXSPI-6.5 Dc-OMA
             EXSPI-6.5 OMA Application Event Errors
IMAP4
             EXSPI-6.X IMAP4 Failed Connection Rate
             EXSPI-6.X IMAP4 Rejected Connection Rate
             EXSPI-6.X IMAP4 Connections
             EXSPI-6.X Dc-IMAP4 Performance
             EXSPI-6.X IMAP4 Port Response
MAPI
             EXSPI-6.X Information Store RPC Requests
             EXSPI-6.X Information Store RPC Operations
             EXSPI-6.X Information Store RPC Averaged Latency
Outlook 2003
             EXSPI-6.5 Dc-Outlook Client
             EXSPI-6.5 Outlook Client Latency
             EXSPI-6.5 Outlook Client RPC Failure Rate

Client Accessibility 
(cont)

OWA
Front End:
             EXSPI-6.X OWA Current Connections
             EXSPI-6.X Dc-OWA Front End
             EXSPI-6.X HTTP Port Response
Back End:
             EXSPI-6.X Dc-OWA Back End
POP3
             EXSPI-6.X POP3 Failed Connection Rate
             EXSPI-6.X POP3 Rejected Connection Rate
             EXSPI-6.X POP3 Connections
             EXSPI-6.X Dc-POP3 Performance
             EXSPI-6.X POP3 Port Response

Cluster EXSPI-6.X Exchange Cluster Discovery SysLog
EXSPI-6.X Cluster Connection Limits

Exchange 2003 
Auto Deploy Groups Policies
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Directory EXSPI-6.X DSAccess Cache Hit-Miss Ratio
EXSPI-6.X Dc-DSAccess Performance
EXSPI-6.X DSAccess Application Errors

Information Store Epoxy
             EXSPI-6.5 Epoxy Store Out Queue Length
             EXSPI-6.5 Epoxy Client Out Queue Length
Full Text Index
             EXSPI-6.X Dc-Full Text Index
             EXSPI-6.X-0074
Mailbox
             EXSPI-6.X IS Mailbox Average Delivery Time
             EXSPI-6.X IS Mailbox Receive Queue Length
             EXSPI-6.X IS Mailbox Send Queue Length
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X 1h-Mailbox Space Usage
             EXSPI-6.X Dc-Mailbox IS Sum. Data
             EXSPI-6.X Dc-Mailbox Data
             EXSPI-6.X Dc-IS Mailbox Performance
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X-0070
Performance
             EXSPI-6.X Information Store Db Cache Size
             EXSPI-6.X Information Store Db Log Threads Waiting
             EXSPI-6.X Information Store Db Log Record Stalls per sec
             EXSPI-6.X Information Store Db Log Writes per sec
             EXSPI-6.X Dc-Information Store Performance
             EXSPI-6.X Information Store User Count
             EXSPI-6.X Information Store VM Largest Block
             EXSPI-6.X Information Store VM 16MB Blocks
             EXSPI-6.X Information Store VM Large Block Bytes
             EXSPI-6.X Check Memory Configuration
             EXSPI-6.5 Information Store Additional Heaps
             EXSPI-6.5 Information Store Memory Errors
             EXSPI-6.5 Information Store Heap Memory Errors

Exchange 2003 
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Information Store 
(cont)

Public Folder
             EXSPI-6.X IS Public Replication Queue Length
             EXSPI-6.X 1h-Public Folder Space Usage
             EXSPI-6.X Dc-IS Public Folder Performance
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X Dc-Public Folder Data
             EXSPI-6.X IS Public Receive Queue Length
             EXSPI-6.X Dc-Public IS Sum. Data
             EXSPI-6.X IS Public Send Queue Length
             EXSPI-6.X IS Public Average Delivery Time
             EXSPI-6.X-0072
Transaction Log
             EXSPI-6.X-0004
             EXSPI-6.X-0008
             EXSPI-6.X Transaction Log BackUp Check
             EXSPI-6.X Transaction Log Space Usage
Virus Scan
             EXSPI-6.X Virus Scan Messages Quarantined per Sec
             EXSPI-6.X Virus Scan Files Cleaned per Sec
            EXSPI-6.X Virus Scan Queue Length
             EXSPI-6.X Virus Scan Files Quarantined per sec
             EXSPI-6.X Virus Scan Messages Cleaned per Sec
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Messaging cc:Mail Connector
             EXSPI-6.X 1h-ccMail Connector
             EXSPI-6.X-0091
             EXSPI-6.X 5m-ccMail Connector
             EXSPI-6.X-0093
             EXSPI-6.X-0092
             EXSPI-6.X-0090
Lotus Notes Connector
             EXSPI-6.X Lotus Notes Process Monitor
             EXSPI-6.X-0094
             EXSPI-6.X 1h-Lotus Notes Connector
             EXSPI-6.X-0095
             EXSPI-6.X-0096
             EXSPI-6.X-0096
             EXSPI-6.X 5m-Lotus Notes Connector
MTA
             EXSPI-6.X MTA Work Queue Length
             EXSPI-6.X Dc-MTA Performance
             EXSPI-6.X MTA Rejected Inbound Messages
             EXSPI-6.X MTA Connection Queue Lengths
             EXSPI-6.X MTA Failed Outbound Associations
             EXSPI-6.X MTA Failed Conversions
             EXSPI-6.X MTA Message Delay
             EXSPI-6.X MTA Connection Message Delay
             EXSPI-6.X MTA Rejected Inbound Associations
             EXSPI-6.X Dc-X.400 Service MTA Queue
             EXSPI-6.X-0075
NNTP
             EXSPI-6.X 1h-NNTP
             EXSPI-6.X-0058
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Messaging (cont) SMTP
             EXSPI-6.X SMTP Messages Pending Routing
             EXSPI-6.X SMTP Categorizer Queue Length
             EXSPI-6.X SMTP Local Queue Length
             EXSPI-6.X SMTP Local Retry Queue Length
             EXSPI-6.X Dc-SMTP Server Performance
             EXSPI-6.X Dc-SMTP Queues
             EXSPI-6.X SMTP NDR Percentage
             EXSPI-6.X SMTP Outbound Connections Refused
             EXSPI-6.X SMTP Remote Queue Length
             EXSPI-6.X SMTP Remote Retry Queue Length
             EXSPI-6.X Dc-SMTP Virtual Server Storage
             EXSPI-6.X-0082
             EXSPI-6.X-0083
             EXSPI-6.X-0084
             EXSPI-6.X-0085
             EXSPI-6.X-0086
             EXSPI-6.X-0087
             EXSPI-6.X SMTP Port Response
             EXSPI-6.X SMTP Anonymous Relay
             EXSPI-6.X SMTP Directories
             EXSPI-6.X SMTP Services
Tracking Log
             EXSPI-6.X Dc-TrackLog Data
             EXSPI-6.X Dc-TrackLog SLA Delivery
             EXSPI-6.X Dc-Message Tracking Log Space Usage
             EXSPI-6.X-0076
             EXSPI-6.X Message Tracking State
             EXSPI-6.X Tracking Log ACL

ovo Exchange SPI 
core

Data Collection
             EXSPI-6.X exspi Agent Configuration
             EXSPI-6.X Messages
Exchange Discovery
             EXSPI-6.X Check Discovery
             EXSPI-6.X Exchange Service Discovery
             EXSPI-6.X Exchange Cluster Discovery SysLog
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Exchange 2003 Manual Deploy Policies

Exchange 2003 
Manual Deploy 
Groups Policies

Site Replication 
Service

           EXSPI-6.X SRS Process Monitor
           EXSPI-6.X SRS Service
           EXSPI-6.X-0112
           EXSPI-6.X SRS Pending Synchronizations
           EXSPI-6.X SRS Data Space Usage
           EXSPI-6.X SRS Remaining Updates
           EXSPI-6.X-0113

Active Directory 
Connector Server

           EXSPI-6.X ADC Process Monitor
           EXSPI-6.X ADC Service
           EXSPI-6.X ADC Import Failure Rate
           EXSPI-6.X ADC Operation Failure Rate

Exchange Server
 

Availability
             EXSPI-6.X Server State
             EXSPI-6.X Exchange Application Information
             EXSPI-6.X Exchange System Information
             EXSPI-6.X Exchange Application Warnings
             EXSPI-6.X Exchange System Warnings
Transaction Log
             EXSPI-6.X-0005
             EXSPI-6.X-0006
             EXSPI-6.X Transaction Log Storage Use
Message Delivery
             EXSPI-6.X End to End Message Ping
Client Accessibility
             EXSPI-6.X Client Message Read
             EXSPI-6.X Client MAPI Logon
             EXSPI-6.X Client Message Send
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Exchange 2000 Auto Deploy Policies

Exchange 2000
Auto Deploy Groups Policies

Availability EXSPI-6.X Queue State
EXSPI-6.X Connector State
EXSPI-6.X Exchange System Errors
EXSPI-6.X Link State
EXSPI-6.X Exchange Services
EXSPI-6.X Process Monitor
EXSPI-6.X Exchange Application Errors
EXSPI-6.X Inactive Process Monitor
EXSPI-6.X Check CircularLogging Off 
EXSPI-6.X Check CircularLogging ON
EXSPI-6.X Check MailBox on Front-End
EXSPI-6.X Heap DeCommit Threshold
EXSPI-6.X Hotfix Installed 
EXSPI-6.X SSL for HTTPVS
EXSPI-6.X TransactionLog BackUp
EXSPI-6.X UrlScan State

Client Accessibility IMAP4
             EXSPI-6.X IMAP4 Failed Connection Rate
             EXSPI-6.X IMAP4 Rejected Connection Rate
             EXSPI-6.X IMAP4 Connections
             EXSPI-6.X Dc-IMAP4 Performance
             EXSPI-6.X IMAP4 Port Response
MAPI
             EXSPI-6.X Information Store RPC Requests
             EXSPI-6.X Information Store RPC Operations
             EXSPI-6.X Information Store RPC Averaged Latency
OWA
Front End:
             EXSPI-6.X OWA Current Connections
             EXSPI-6.X Dc-OWA Front End
             EXSPI-6.X HTTP Port Response
Back End:
             EXSPI-6.X Dc-OWA Back End
POP3
             EXSPI-6.X POP3 Failed Connection Rate
             EXSPI-6.X POP3 Rejected Connection Rate
             EXSPI-6.X POP3 Connections
             EXSPI-6.X Dc-POP3 Performance
             EXSPI-6.X POP3 Port Response
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Cluster EXSPI-6.X Exchange Cluster Discovery SysLog
EXSPI-6.0 Exchange Cluster Discovery AppLog
EXSPI-6.X Cluster Connection Limits

Directory EXSPI-6.X DSAccess Cache Hit-Miss Ratio
EXSPI-6.X Dc-DSAccess Performance
EXSPI-6.X DSAccess Application Errors

Information Store Epoxy
             EXSPI-6.0 Epoxy Store Out Queue Length
             EXSPI-6.0 Epoxy Client Out Queue Length
Full Text Index
             EXSPI-6.X Dc-Full Text Index
             EXSPI-6.X-0074
Mailbox
             EXSPI-6.X IS Mailbox Average Delivery Time
             EXSPI-6.X IS Mailbox Receive Queue Length
             EXSPI-6.X IS Mailbox Send Queue Length
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X 1h-Mailbox Space Usage
             EXSPI-6.X Dc-Mailbox IS Sum. Data
             EXSPI-6.X Dc-Mailbox Data
             EXSPI-6.X Dc-IS Mailbox Performance
             EXSPI-6.0 IS Mailbox Average Local Delivery Time
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X-0070
Performance
             EXSPI-6.X Information Store Db Cache Size
             EXSPI-6.X Information Store Db Log Threads Waiting
             EXSPI-6.X Information Store Db Log Record Stalls per sec
             EXSPI-6.X Information Store Db Log Writes per sec
             EXSPI-6.X Dc-Information Store Performance
             EXSPI-6.X Information Store User Count
             EXSPI-6.X Information Store VM Largest Block
             EXSPI-6.X Information Store VM 16MB Blocks
             EXSPI-6.X Information Store VM Large Block Bytes
             EXSPI-6.X Check Memory Configuration
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Information Store 
(cont)

Public Folder
             EXSPI-6.X IS Public Replication Queue Length
             EXSPI-6.X 1h-Public Folder Space Usage
             EXSPI-6.0 IS Public Average Local Delivery Time
             EXSPI-6.X Database Mounted Search
             EXSPI-6.X Database Mounted Check
             EXSPI-6.X Dc-Public Folder Data
             EXSPI-6.X IS Public Receive Queue Length
             EXSPI-6.X Dc-Public IS Sum. Data
             EXSPI-6.X Dc-IS Public Folder Performance
             EXSPI-6.X IS Public Send Queue Length
             EXSPI-6.X IS Public Average Delivery Time
             EXSPI-6.X-0072
Transaction Log
             EXSPI-6.X-0004
             EXSPI-6.X-0008
             EXSPI-6.X Transaction Log BackUp Check
             EXSPI-6.X Transaction Log Space Usage
Virus Scan
             EXSPI-6.X Virus Scan Messages Quarantined per Sec
             EXSPI-6.X Virus Scan Files Cleaned per Sec
            EXSPI-6.X Virus Scan Queue Length
             EXSPI-6.X Virus Scan Files Quarantined per sec
             EXSPI-6.X Virus Scan Messages Cleaned per Sec
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Messaging cc:Mail Connector
             EXSPI-6.X 1h-ccMail Connector
             EXSPI-6.X-0091
             EXSPI-6.X 5m-ccMail Connector
             EXSPI-6.X-0093
             EXSPI-6.X-0092
             EXSPI-6.X-0090
Lotus Notes Connector
             EXSPI-6.X Lotus Notes Process Monitor
             EXSPI-6.X-0094
             EXSPI-6.X 1h-Lotus Notes Connector
             EXSPI-6.X-0095
             EXSPI-6.X-0096
             EXSPI-6.X-0097
             EXSPI-6.X 5m-Lotus Notes Connector
MTA
             EXSPI-6.X MTA Work Queue Length
             EXSPI-6.X Dc-MTA Performance
             EXSPI-6.X MTA Rejected Inbound Messages
             EXSPI-6.X MTA Connection Queue Lengths
             EXSPI-6.X MTA Failed Outbound Associations
             EXSPI-6.X MTA Failed Conversions
             EXSPI-6.X MTA Message Delay
             EXSPI-6.X MTA Connection Message Delay
             EXSPI-6.X MTA Rejected Inbound Associations
             EXSPI-6.X Dc-X.400 Service MTA Queue
             EXSPI-6.X-0075
NNTP
             EXSPI-6.X 1h-NNTP
             EXSPI-6.X-0058
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Messaging (cont) SMTP
             EXSPI-6.X SMTP Messages Pending Routing
             EXSPI-6.X SMTP Categorizer Queue Length
             EXSPI-6.X SMTP Local Queue Length
             EXSPI-6.X SMTP Local Retry Queue Length
             EXSPI-6.X Dc-SMTP Server Performance
             EXSPI-6.X Dc-SMTP Queues
             EXSPI-6.X SMTP NDR Percentage
             EXSPI-6.X SMTP Outbound Connections Refused
             EXSPI-6.X SMTP Remote Queue Length
             EXSPI-6.X SMTP Remote Retry Queue Length
             EXSPI-6.X Dc-SMTP Virtual Server Storage
             EXSPI-6.X-0082
             EXSPI-6.X-0083
             EXSPI-6.X-0084
             EXSPI-6.X-0085
             EXSPI-6.X-0086
             EXSPI-6.X-0087
             EXSPI-6.X SMTP Port Response
             EXSPI-6.X SMTP Anonymous Relay
             EXSPI-6.X SMTP Directories
             EXSPI-6.X SMTP Services
Tracking Log
             EXSPI-6.X Dc-TrackLog Data
             EXSPI-6.X Dc-TrackLog SLA Delivery
             EXSPI-6.X Dc-Message Tracking Log Space Usage
             EXSPI-6.X-0076
             EXSPI-6.X Message Tracking State
             EXSPI-6.X Tracking Log ACL
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Optional Exchange 
Server Roles

EXSPI Chat Service
             EXSPI-6.0-0836
             EXSPI-6.0-0835
             EXSPI-6.0 15m-Chat
             EXSPI-6.0-0834
             EXSPI-6.0-0833
             EXSPI-6.0-0831
             EXSPI-6.0-0830
             EXSPI-6.0 Dc-Chat Service Clients and Channels
EXSPI Conferencing Service
       EXSPI Conference Server
              EXSPI-6.0-0801
              EXSPI-6.0 10m-Conf
              EXSPI-6.0 Dc-ConfTrends
              EXSPI-6.0-0800
              EXSPI-6.0-0802
       EXSPI Conferencing Bridge
               EXSPI-6.0-0805
               EXSPI-6.0 10m-ConfBridge
               EXSPI-6.0-0807
               EXSPI-6.0-0806
EXSPI MCU Server
               EXSPI-6.0-0803
               EXSPI-6.0 10m-MCU
               EXSPI-6.0 Dc-MCU
               EXSPI-6.0-0804
EXSPI Instant Messaging
             EXSPI-6.0-0842
             EXSPI-6.0-0846
             EXSPI-6.0-0845
             EXSPI-6.0 Dc-Instant Messaging Enabled Users
             EXSPI-6.0-0841

ovo Exchange SPI 
core

Data Collection
             EXSPI-6.X exspi Agent Configuration
             EXSPI-6.X Messages
Exchange Discovery
             EXSPI-6.X Check Discovery
             EXSPI-6.X Exchange Service Discovery
             EXSPI-6.X Exchange Cluster Discovery SysLog
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Exchange 2000 Manual Deploy Policies

Exchange 2000 
Manual Deploy 
Groups Policies

Site Replication 
Service

           EXSPI-6.X SRS Process Monitor
           EXSPI-6.X SRS Service
           EXSPI-6.X-0112
           EXSPI-6.X SRS Pending Synchronizations
           EXSPI-6.X SRS Data Space Usage
           EXSPI-6.X SRS Remaining Updates
           EXSPI-6.X-0113

Active Directory 
Connector Server

           EXSPI-6.X ADC Process Monitor
           EXSPI-6.X ADC Service
           EXSPI-6.X ADC Import Failure Rate
           EXSPI-6.X ADC Operation Failure Rate

Exchange Server
 

Availability
             EXSPI-6.X Server State
             EXSPI-6.X Exchange Application Information
             EXSPI-6.X Exchange System Information
             EXSPI-6.X Exchange Application Warnings
             EXSPI-6.X Exchange System Warnings
Transaction Log
             EXSPI-6.X-0005
             EXSPI-6.X-0006
             EXSPI-6.X Transaction Log Storage Use
Message Delivery
             EXSPI-6.X End to End Message Ping
Client Accessibility
             EXSPI-6.X Client Message Read
             EXSPI-6.X Client MAPI Logon
             EXSPI-6.X Client Message Send
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Manual Deployment of Exchange 2000 and 2003 Policies

By default, groups of Microsoft Exchange SPI policies deploy automatically when relevant 
applications or services are discovered on managed nodes. The setting to automatically deploy 
policies when services are discovered can be turned off, and each group of policies can be 
deployed manually. 

If manual deployment of policies is desired, use the Recommended Policy deployment tables in 
the Microsoft Exchange SPI online help to determine which policy groups should be deployed 
to manage an Exchange server.

Perform the following steps to deploy policies manually:

1 Select the desired policies. 

2 Right-click, and then click All Tasks → Deploy on..... 

3 Select the nodes on which to deploy the policies. 

4 Click Launch...

Manual Deploy Policy Groups

There is also a Manual Deploy folder containing policies, located under Policy Management 
Policy Groups SPI for Exchange, and the relevant Exchange version. These folders contain 
policies requiring additional configuration or special circumstances for deployment. 

Time Interval before Generation of Reports

Microsoft Exchange SPI reports are not available until data has been gathered to the 
management server from the managed nodes. This occurs each night, so at least one day of 
activity is needed for the reports to populate. Where a report type requires data from a Sat/
Sun collection, those reports require a weekend prior to generation.

The SPI for Exchange Reports folder is not be created until data is collected on nodes and the 
Service Reporter consolidation process has run, which is usually 24 hours after a node 
becomes managed.   

To display a report, select the desired report, right click, and then select Show report.

Microsoft Exchange SPI Reports

Reports enable you to analyze the data collected by the Microsoft Exchange SPI. You can use 
HP Reporter in conjunction with HPOM to generate reports. After the HP Operations agent 
collects metric data from the managed nodes, HP Reporter can create web-based reports for 
the collected data.

The SPI for Exchange Reports and Graphs folder is not created until data is collected on 
nodes and the Service Reporter consolidation process has run. Out of the box, the Reporter 
Data consolidation process (gathercoda.exe) is scheduled to run each day shortly after 
midnight.
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Exchange 2007 Reports

If you install HP Reporter in your environment, you can access Microsoft Exchange SPI 
reports from the HPOM console. To view reports for Microsoft Exchange Server 2007, expand 
Reports → SPI for Exchange 2007 in the console tree.

Before you start viewing reports from the HPOM console, you must integrate HP Reporter 
and the Microsoft Exchange SPI. To complete the integration, perform the following tasks:

Task 1: Install the Microsoft Exchange SPI Report Packs

You must install the Microsoft Exchange SPI report packs on the HP Reporter server from the 
SPI DVD. To install the Microsoft Exchange SPI report packs. follow these steps:

1 Insert the HP Operations Smart Plug-ins DVD into the DVD-ROM of the HP Reporter 
server.

2 In the Product Selection screen of the installation wizard, select the Reports option under 
the Microsoft Exchange SPI, and then begin installation.

Task 2: Integrate HP Reporter with HPOM

After you install the report pack, you must integrate the HP Reporter with HPOM. To achieve 
this, follow these steps:

3 In the HP Reporter console, click File → Configure → Options. The Configure Reporter 
Options dialog box opens.

4 Configure Reporter Options dialog box, In the HPOM for Windows setting section, of the 
Configure Reporter Options dialog box, specify the following:

— HPOM Management Server: Enter the fully qualified domain name of the HPOM 
management server.

— Domain\User Name: Enter a user name (with domain) that has administrative 
privilege on the HPOM management server.

— Password: Enter password of the user.

5 Click OK.

6 In the HP Reporter console, click Action → Run → Run All. The HP Reporter starts running 
all necessary services. After some time, you can view the Reports item in the console tree 
of the HPOM console.

The SPI for Microsoft Exchange Server 2007 provides the following reports:

• Exchange 2007 Mailbox Details by Server — This report contains information about 
mailboxes on the Mailbox Server. This report displays information sorted by disk space 
usage and grouped by storage group and database.

• Exchange 2007 Top 100 Mailboxes — This report lists the top 100 mailboxes by disk space 
usage across all Exchange 2007 Mailbox Servers.

• Exchange 2007 Server Inactive Mailboxes by Server — This report lists the mailboxes 
that were not used to send mails in 20, 40 and 60 or more days and the number of days for 
which the mailboxes were not used.

If you use OVO for Windows 7.50, you can use the embedded Reporter component 
instead of  a commercial version of HP Reporter. You can access reports from the 
OVO console by expanding Reports & Graphs → Reports → SPI for Exchange 2007.
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• Exchange 2007 Mailbox Store Message Trends by Server — This report contains 
summary and detailed trend graphs showing Mailbox Store message volumes.  

• Exchange 2007 Public Folder Messaging Trends by Server — This report contains 
summary and detail trend graphs showing Public Folder Store message volumes.

• Exchange 2007 Users and Connections by Server — This report provides a graph of the 
average number of users and connections counts for hours of the day over a given time 
period.

• Exchange 2007 POP3 Connections by Server — This report provides a graph of the 
average POP3 connection counts for hours of the day over a given time period.

• Exchange 2007 IMAP4 Connections by Server — This report provides a graph of the 
average IMAP4 connection counts for hours of the day for a given time period.

• Exchange 2007 SMTP Receive Messaging Trends by Server — This report provides a 
graphs showing the volume of simple mail transport protocol (SMTP) messages received 
by the receive connectors on transport servers.

• Exchange 2007 SMTP Send Messaging Trends by Server — This report contains trend 
graphs showing the volume of simple mail transport protocol (SMTP) messages sent by 
the send connectors on transport servers.

Exchange 2003 Reports

Exchange SPI reports for Exchange 2003 are located on the HPOM console under Reports → 
SPI for Exchange 2000, in the following groups:

Client Access 

Exchange 2003 ActiveSync Usage 

Exchange 2003 ActiveSync Notifications 

Exchange 2003 and 2000 IMAP4 Connections

Exchange 2003 and 2000 MAPI Logon SLA 

Exchange 2003 and 2000 Message Read SLA 

Exchange 2003 and 2000 Message Send SLA 

Exchange 2003 and 2000 OWA Authentications

Exchange 2003 and 2000 OWA Connections

Exchange 2003 and 2000 OWA Usage 

Exchange 2003 OMA Sync Usage 

Exchange 2003 and 2000 POP3 Connections

Exchange 2003 and 2000 Messaging Ports 

Exchange Server 

Exchange 2000 and 2003 System Information Summary 

If using OVO for Windows 7.50, expand Reports and Graphs → Reports → SPI for Exchange 2000 
in the console tree.
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Information Store

Exchange 2003 and 2000 Full Text Indexing Stats   

Exchange 2003 and 2000 IS Users and Connections 

Exchange 2003 and 2000 Transaction Log Stats   

Mailbox Store 

Exchange 2003 and 2000 Inactive Mailboxes 

Exchange 2003 and 2000 Mailbox Details 

Exchange 2003 and 2000 Mailbox Store Stats

Exchange 2003 and 2000 Mailbox Summary 

Exchange 2003 and 2000 Mailbox Store Msg Trends   

Exchange 2003 and 2000 Mailbox Usage Trends 

Exchange 2003 and 2000 Top 100 Mailboxes 

Messaging 

Exchange 2003 and 2000 All Local Msg Delivery SLA 

Exchange 2003 and 2000 MTA Msg Trends 

Exchange 2003 and 2000 MTA Queue Data Stats 

Exchange 2003 and 2000 SMTP Connections 

Exchange 2003 and 2000 SMTP Msg Trends 

Exchange 2003 and 2000 SMTP Virtual Server Stats

Exchange 2003 and 2000 Message Tracking Stats 

Exchange 2003 and 2000 Top Destinations

Exchange 2003 and 2000 Top Recipients 

Exchange 2003 and 2000 Top Senders

Exchange 2003 and 2000 Top Sources

Exchange 2003 and 2000 Message Delivery SLA

Public Folder Store

Exchange 2003 and 2000 Folder Summary 

Exchange 2003 and 2000 Folder Usage Trends 

Exchange 2003 and 2000 Inactive Folders 

Exchange 2003 and 2000 Public Folder Store Stats 

Exchange 2003 and 2000 Public Folder Store Msg Tnd 

Exchange 2000 and 2003 Top 100 Public Folders 
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Exchange 2000 Reports

Exchange SPI reports for Exchange 2000 are located on the HPOM console under Reports and 
Graphs → Reports → SPI for Exchange 2000, in the following groups:

Chat

Exchange 2000 Chat Trends

Client Access

Exchange 2003 and 2000 IMAP4 Connections

Exchange 2003 and 2000 MAPI Logon SLA 

Exchange 2003 and 2000 MAPI Send SLA 

Exchange 2003 and 2000 Message Read SLA 

Exchange 2003 and 2000 OWA Authentications

Exchange 2003 and 2000 OWA Connections

Exchange 2003 and 2000 OWA Usage 

Exchange 2003 and 2000 POP3 Connections 

Exchange 2003 and 2000 Messaging Ports 

Conferencing 

Exchange 2000 Conferencing Server Trends

Exchange 2000 MCU Trends 

Exchange Server 

Exchange 2003 and 2000 System Information Summary 

Information Store

Exchange 2003 and 2000 IS Users and Connections

Exchange 2003 and 2000 Full Text Indexing Stats

Exchange 2003 and 2000 Transaction Log Stats 

Instant Messaging    

Exchange 2000 Instant Messaging Availability Trends

Exchange 2000 Instant Messaging Users Growth

Mailbox Store 

Exchange 2003 and 2000 Inactive Mailboxes   

Exchange 2003 and 2000 Mailbox Details 

Exchange 2003 and 2000 Mailbox Store Stats 

Exchange 2003 and 2000 Mailbox Summary 

Exchange 2003 and 2000 Mailbox Store Msg Trends 

Exchange 2003 and 2000 Mailbox Usage Trends   
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Exchange 2000/2003 Top 100 Mailboxes 

Messaging

Exchange 2003 and 2000 All Local Msg Delivery SLA 

Exchange 2003 and 2000 MTA Msg Trends 

Exchange 2003 and 2000 MTA Queue Data Stats 

Exchange 2003 and 2000 SMTP Msg Trends 

Exchange 2003 and 2000 SMTP Connections

Exchange 2003 and 2000 Message Tracking Stats    

Exchange 2003 and 2000 Top Destinations 

Exchange 2003 and 2000 Top Recipients 

Exchange 2003 and 2000 Top Senders 

Exchange 2003 and 2000 Top Sources 

Exchange 2003 and 2000 Message Delivery SLA

Exchange 2003 and 2000 SMTP Virtual Server Stats 

Public Folder Store 

Exchange 2003 and 2000 Folder Summary 

Exchange 2003 and 2000 Folder Usage Trends

Exchange 2003 and 2000 Inactive Folders 

Exchange 2003 and 2000 Public Folder Store Stats

Exchange 2003 and 2000 Public Folder Store Msg Tnd 

Exchange 2000/2003 Top 100 Public Folders 
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Microsoft Exchange SPI Graphs

Microsoft Exchange SPI comes with a set of pre-configured graphs. They are located on the 
HPOM console tree in the Graphs folders. You can access this Graphs folder only if you install 
HP Performance Manager on the HPOM management server. 

If you use OVO for Windows 7.50, you can use the embedded HP OpenView Performance 
Manager component instead of a commercial version of HP Performance Manager. To view 
graphs from the OVO console, expand Reports and Graphs → Graphs → SPI for Exchange 2007.

To display a graph from the HPOM console, double-click the desired graph. The Display graph 
associated with dialog box opens:

Select the nodes to retrieve data from, and then click Next. In the following screen, specify the 
date range, and the level of granularity, and then click Show.
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Figure 9 Example DSAccess Hit-Miss Ratio Graph

Exchange 2007 Graphs

Microsoft Exchange SPI provides pre-configured graphs for Microsoft Exchange Server 2007. 
To view these graphs from the HPOM console, you must install HP Performance Manager on 
the HPOM management server. Expand Graphs → SPI for Exchange 2007 in the console tree.

Client Access

Outlook Client Failures: This graph shows the percentage of RPCs failed in different 
categories.

IMAP4 Connections: This graph shows the IMAP4 connection activity.

MAPI RPC Performance: This graph shows metrics of information store RPC requests and 
RPC operations rate (operations/sec). 

If you use OVO for Windows 7.50, you can use the embedded HP OpenView Performance 
Manager component instead of a commercial version of HP Performance Manager. To view 
graphs from the OVO console, expand Reports and Graphs → Graphs → SPI for Exchange 2007.
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MAPI RPC Latency Levels: This graph shows the number of successful RPCs with different 
Outlook client latency levels. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Outlook Client RPC Performance: This graph shows the Outlook Client RPC 
Performance. 

Information Store

Information Store Users and Connections: This graph shows user and connection count 
metrics for the current day. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends.  

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage.  

Virtual Memory Largest Block Size: This graph shows the change of the information store 
virtual memory largest block size.  

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average delivery 
times of messages to Exchange server private and public mailboxes. 

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Queues: This graph shows Exchange server public folder store queue 
lengths.

Exchange 2003 Graphs

Microsoft Exchange SPI provides pre-configured graphs for Microsoft Exchange Server 2003. 
To view these graphs from the HPOM console, you must install HP Performance Manager on 
the HPOM management server. Expand Graphs → SPI for Exchange 2007 in the console tree.

Client Access 

ActiveSync Performance: This graph shows the ActiveSync Microsoft Exchange active 
directory, connection, and pending requests. 

If you use OVO for Windows 7.50, you can use the embedded HP OpenView Performance 
Manager component instead of a commercial version of HP Performance Manager. To view 
graphs from the OVO console, expand Reports and Graphs → Graphs → SPI for Exchange 2007.
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ActiveSync Users: This graph shows the current users of Microsoft Exchange 
ActiveSync. 

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Latency levels: This graph shows the number of successful RPCs with 
Outlook client latency levels.

MAPI RPC Performance: This graph shows metrics of information store RPC requests 
and RPC operations rate (operations/sec). 

Number of Successful RPCs with Different Latency Levels: This graph shows the 
number of successful RPCs with different Outlook client latency levels. 

Outlook Client RPC Performance: This graph shows the Outlook Client RPC 
Performance. 

OWA Connections: This graph shows the OWA connection activity. 

OMA Response Time: This graph shows the MSExchangeOMA last response time in 
seconds. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache hit 
and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space on 
the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service space 
usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the information 
store virtual memory largest block size. 

Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log space 
usage on the Exchange server. 
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Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 service 
MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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Exchange 2000 Graphs

Exchange 2000 graphs are arranged in the following service groups:

Client Access

IMAP4 Connections: This graph shows the IMAP4 connection activity. 

IMAP4 Performance: This graph shows the IMAP4 transaction activity. 

MAPI RPC Performance: This graph shows metrics of information store RPC requests 
and RPC operations rate (operations/sec). 

OWA Connections: This graph shows the OWA connection activity. 

POP3 Connections: This graph shows the POP3 connection activity. 

POP3 Performance: This graph shows POP3 messages delivered to mailboxes. 

Directory Service

DSAccess Cache Hit-Miss Ratio: This graph shows MSExchangeDSAccess cache hit 
and miss ratio for Exchange 2000 and 2003 servers.

Site Replication Service Space Free: This graph shows the percentage of free space on 
the Site Replication Service volume.

Site Replication Service Space Used: This graph shows Site Replication Service space 
usage on the Exchange server.

Information Store

Full-Text Indexing Space Usage: This graph shows disk space usage for full-text 
indexing of Microsoft Exchange information stores. 

Information Store Users and Connections: This graph shows user and connection 
count metrics, for the current day. 

Transaction Log Percentage Free: This graph shows the percentage of free space on 
the transaction log volumes. 

Transaction Log Space Used: This graph shows Exchange server transaction log space 
usage on the Exchange server. 

Virtual Memory 16MB Free Block Trend: This graph shows information store virtual 
memory 16MB free block use trends. 

Virtual Memory Large Free Block Megabytes Usage: This graph shows information 
store virtual memory large free block megabytes usage. 

Virtual Memory Largest Block Size: This graph shows the change of the information 
store virtual memory largest block size. 

Mailbox Store

Mailbox Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of messages to Exchange server private and public mailboxes. 

Mailbox Store EDB Database Statistics: This graph shows Exchange server private 
mailbox store database statistics.

Mailbox Store Message Volume: This graph shows Exchange server private mailbox 
volume.
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Mailbox Store Streaming Database Statistics: This graph shows Exchange mailbox 
store streaming database statistics.

Mailbox Store Storage Usage: This graph shows mailbox store storage usage.

Mailbox Store Queues: This graph shows Exchange server mailbox store queue lengths.

Messaging

MTA Message Volume: This graph shows Exchange server Message Transfer Agent 
volume. 

MTA Queues: This graph shows Exchange server queue lengths. 

SMTP Connections: This graph shows SMTP virtual server connections on the 
Exchange server. 

SMTP Message Volume: This graph shows SMTP volume on the Exchange server. 

SMTP Queues: This graph shows SMTP server queues on the Exchange server 

SMTP Queue, Badmail, and Pickup Counts: This graph shows SMTP badmail, 
pickup and queue item counts for each SMTP virtual server. 

SMTP Queue, Badmail, and Pickup Size: This graph shows SMTP badmail, pickup 
and queue sizes for each SMTP virtual server. 

X400 MTA Queue Space Usage: This graph shows disk space usage for X400 service 
MTA queue.

Public Folder Store

Public Folder Store Delivery Time: This graph shows hourly metrics for the average 
delivery times of local messages to Exchange servers. 

Public Folder Store EDB Database Statistics: This graph shows Exchange server 
public folder store (edb) database statistics. 

Public Folder Store Message Volume: This graph shows Exchange server public folder 
volume. 

Public Folder Store Streaming Database Statistics: This graph shows Exchange 
Public Folder store streaming database statistics. 

Public Folder Store Storage Usage: This graph shows Exchange server public folder 
usage. 

Public Folder Store Queues: This graph shows Exchange server public folder store 
queue lengths.
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8 Microsoft Exchange SPI Tools
Tools enable you to perform tasks to facilitate Microsoft Exchange Server monitoring. With 
the help of tools, you can perform certain configuration tasks on managed nodes to start 
monitoring Microsoft Exchange Server.

Microsoft Exchange SPI Tools for Microsoft Exchange Server 
2007

The following tools are available:

• Create Data Sources — When you run this tool on a Microsoft Exchange Server 2007 
node, it creates databases on the HP Operations agent’s data store, which can be used by 
collectors to log metric data. By default, it creates databases in the embedded 
performance component (CODA) of the agent. If you have HP Performance Agent installed 
on the node, the Create Data Source tool creates databases on HP Performance Agent. In 
that case, if you want, you can configure to log data on CODA instead of HP Performance 
Agent.

• Register DataCollectors — This tool registers COM components on the node required 
by the collectors.

• Start ExData Collection Manager — This tool starts the collection manager process on 
the managed node. Collection manager is a background process, which runs on a managed 
node. Collection manager creates objects necessary to analyze and publish the data 
collected by individual collectors.

• Start PowerShell Collector — This tool starts another background process — 
PowerShell collector — on the managed node. 

• Stop PowerShell Collector — Run this tool to stop the PowerShell collector process on 
a managed Microsoft Exchange Server 2007 node.

• Stop ExData Collection Manager — Run this tool to stop the collection manager 
process on a managed Microsoft Exchange Server 2007 node.

• PowerShell Collection Configuration Utility — This tool launches the PowerShell 
collection configuration utility. The PowerShell collection configuration utility enables you 
to create and modify collection definitions. A collection is a description that specifies the 
mechanism to collect, analyze, and store metric data for Microsoft Exchange Server 2007. 
With the help of the graphic user interface, you can create new collection definitions, or 
modify existing definitions. 

• Exchange Cluster Configuration — This tool helps you create the apminfo.xml file to 
enable monitoring of Microsoft Exchange Server 2007 cluster nodes. 

• Exchange SPI Trace — This tool sets the trace levels on managed nodes. Launch this 
tool if you need to collect troubleshooting information from nodes. 
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• Self-Healing Info — The Self-Healing Info tool gathers system information, and 
configuration, log, and trace Exchange SPI files, for assisting to troubleshoot problems. 
Gathered information and files are placed in a pre-defined output directory. The data 
collector gathers real-time data, which reduces the probability of troubleshooting with 
stale data.

• Self-Healing Verification — Launch this tool to detect any version mismatch between 
the Microsoft Exchange SPI and the instrumentation files. If the tool detects any 
mismatch, it displays error message  in the tool status window.

• Operations Topology Viewer — This tool presents a 3-dimensional view for your 
Microsoft Exchange Server environment. Using the Operations Topology Viewer, you can 
quickly see sites, routing groups, Exchange servers and their roles within your Exchange 
environment. 

Microsoft Exchange SPI Tools for Microsoft Exchange Server 
2000 and 2003

The following groups of tools are available:

Client SLA Configurations

This tool group contains the following tools for MAPI-based client probes:

• Configure Client MAPI Logon

• Configure Client Message Read 

• Configure Client Message Send 

• MBOX creation for MAPI client based policies 

These tools, used together with associated policies, generate and collect Service Level 
Objective data on various basic client tasks such as logon, sending, and reading E-mail 
messages. See the online Help for more information and procedures.

End-to-End SLA Configuration

• MBOX Config: starts the mailbox configuration program that automatically configures a 
mailbox. The user name and password of a service account with Exchange administrative 
privileges needs to be given for the tool to execute.

• End-to-End Configuration: This tool is a wizard for configuring the Message Delivery 
(Ping) Service Level Objective process on Exchange 2000 and 2003 HPOM managed 
servers.

See Configuring Microsoft Exchange SPI for Message Delivery SLAs on page 53 for more 
information.

Exchange Server Utilities

• Enable Message Tracking: Enables message tracking on Exchange 2000 and Exchange 
2003 servers. 

• Mount Exchange Information Store: This tool can search for and mount dismounted 
information or public folder stores. For more information on this tool, see the Exchange 
SPI online help. 
108 Chapter 8



EXSPI Support

• Trace On/Tracing Off: This tool enables and disables tracing. The default setting is off. 
Tracing is generally used by customer support for troubleshooting purposes.

• Self Healing Info: This tool gathers system information, and configuration, log, and 
trace Microsoft Exchange SPI files to help troubleshoot problems. See the online help for 
more information.

Exchange Topology

•  Operations Topology Viewer: This tool provides for the visualization of Microsoft 
Exchange and directory servers, with a 3-dimensional perspective. See Operations 
Topology Viewer on page 109 for more details.

EXSPI Utilities

• Exchange Cluster Configuration: This tool prints apminfo data, which can be used to 
create the apminfo.xml file used by the Microsoft Exchange SPI to recognize clustered 
instances. For further information about Microsoft Exchange SPI monitoring clusters, see 
Microsoft Exchange SPI Clustering Support on page 59.

• Embedded Performance Component Configuration: This tool creates the 
EXSPI_DATA datasource, classes and metrics. It performs the same functions as the Auto 
Deploy policy EXSPI-6.X exspi Agent Configuration in the ovo Exchange SPI core 
> Data Collection group. The tool lists all current datasources prior to creation of the 
EXSPI_DATA datasource. To verify successful creation, wait a few minutes after initial 
execution, and execute the tool again. See Embedded Performance Component (EPC) 
Schema on page 145 for a complete listing of the EPC schema.

Operations Topology Viewer

The Operations Topology Viewer lets you visualize your Microsoft Exchange Server 2000 and 
2003 environment from a three-dimensional perspective. The viewer is a tool located in the 
HPOM console under Tools →  SPI for Exchange → Exchange 2007 → Exchange Topology, or Tools 
→  SPI for Exchange → Exchange 2000 and 2003 → Exchange Topology. By using this tool, you can 
quickly view routing groups, Exchange servers and their roles within your Exchange 
organization. 

The Operations Topology Viewer tool launches the Operations Topology Viewer window, 
where you can view a three-dimensional topology of your Microsoft Exchange Server 
environment.

To open the Operations Topology Viewer window, follow these steps:

1 In the console tree, expand Tools → SPI for Exchange → Exchange 2007, or Tools → SPI for 
Exchange → Exchange 2000 and 2003 (depending on the Exchange version), and then 
double-click Exchange Topology.

2 In the details pane, double-click Operations Topology Viewer. The Operations Topology 
Viewer window opens.

If you also have the Active Directory SPI installed, the Operations Topology Viewer opens 
with two folders: Exchange Topology and Site Topology. The Site Topology view displays 
Active Directory and Exchange server information. For more details on the Site Topology 
view, see the Active Directory SPI online help and Configuration Guide.
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3 In the left pane of the Operations Topology Viewer window, right-click Forests, and then 
click  Add Forest.... The Connect to Forest dialog box opens.

4 Identify the Domain Controller or Active Directory Domain which will be interrogated for 
Exchange data. Before selecting the Advanced Exchange Data Collection checkbox, see 
Advanced Exchange Data Collection on page 112. Enter the requested information, and 
then click OK.

You are informed when the data collection is complete.

5 Click Close, or check the Close the dialog when complete box if you prefer that this dialog 
close automatically.

6 Select Exchange Topology in the left pane. An untitled view of your Exchange Topology is 
displayed in the right pane. Save this view for future use.
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7 Expand the folders to see your Exchange Organization hierarchy.
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 Advanced Exchange Data Collection

Whether or not the Operations Topology Viewer can collect particular Exchange data will 
depend on the specific permissions assigned to components of your Exchange organization, 
see How can I tell if I have WMI access to an Exchange Server? on page 118.
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On the Connect to Forest... screen, if the option Advanced Data Collection is checked you will 
see the following warning: 

As the warning indicates, the retrieval of this information from a large Exchange 
Organization can take a number of hours. In addition, if it is not successful due to these 
permission limitations, you will not be notified, but must check the error log files for 
connection difficulties to determine if your privileges were sufficient. See Required WMI 
Security Access Permissions on page 119 for details of required WMI permissions and error 
log file locations.

If you select not to initially collect this data from your entire Exchange organization, 
Operations Topology Viewer will try to retrieve this same data when the Properties dialog of 
individual servers is opened. If the permissions allow, the query will retrieve data and 
populate the Dependent DC tab on the server Properties dialog. If Advanced Exchange Data 
Collection is selected initially, this tab on the Properties dialog of any servers (where the 
permissions permit) will be populated.

Site Topology Viewer

If you have an Active Directory SPI license, there will be a Site Topology folder on the console 
tree, beneath the Exchange Topology folder. 

The Site Topology view shows both Active Directory and Exchange servers on the same map, 
when: 

• both SPIs are installed

• the correct permissions were set to allow the collection of Exchange data

• Advanced Exchange Data Collection has been performed with the initial data collection 
(through checking the check box).

The advanced Exchange data collection gathers information about where in the Active 
Directory sites the Exchange servers live, and the dependent domain controllers. This 
Exchange information will be present in the Site Topology map, which opens in the details 
pane when you select this folder on the console tree. For more information on the Site 
Topology view, see the Active Directory SPI online Help and Configuration Guide.

Getting Started with the Exchange Topology Viewer

When the Operations Topology Viewer opens, on the left are folders containing routing groups 
and servers. On the right is a graphical representation that places the routing groups and 
server links within a context. While the tree view on the left displays the hierarchy of the 
Exchange organization, the right pane shows the non-hierarchical relationships among its 
components.
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Accessing functions: The Operations Topology Viewer’s features can be accessed through its 
menu commands, its toolbar buttons, or by context menus within areas on either side of the 
window pane. For complete menu and toolbar descriptions, refer to the SPI for Exchange 
online help.    

Manipulating the Exchange Topology View

You may find when you view the Exchange Topology map that servers do not appear within 
the viewable area. You may also want to resize the viewable area. These and other changes 
are possible as follows: 

Using the Keyboard to Navigate the Map

.

Table 1 Modifying the Operations Topology Viewer  

Tree/map modification How to do it

To move servers to different 
locations within their 
routing groups.

Drag and drop the server to the desired tile within its routing 
group.

To increase/decrease size of 
row/columns in the map’s 
grid.

Right-click the unused space on or off the map and select View 
Properties, and the General tab.

To find a server in the tree. On the map, right-click a server and select Find Server in 
Tree.
(Label appears highlighted)

To find a server in the map. In the tree, right-click on the server and select Find Server 
on Map.
(Label appears bold, with larger text)

Move a routing group to a 
different area of the grid

Method #1:

1. Pressing the left mouse button, click the routing group and 
start to drag and drop to the desired area.

2. Drag to edge of view to auto scroll the view.

Method #2

1. Pressing the left mouse button, select the routing group and 
start to drag and drop to the desired area.

2. Still holding the left mouse button down, use the arrow 
keys to change the view of the map.

Table 2 Keyboard Functionality

Keystroke Map function

← left arrow Scrolls the map view to the left approximately 
one tile width.
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→ right arrow Scrolls the map view to the right approximately 
one tile width.

Home Scrolls the map view to the left extent. (Vertical 
position remains the same).

End Scrolls the map view to the right extent. 
(Vertical position remains the same).

Table 2 Keyboard Functionality

Keystroke Map function
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Accessing Server and Map Properties

After successfully connecting to a forest, the tree is populated and a topological map is 
displayed. 

By right-clicking any discovered Exchange server in either the tree or the map and selecting 
Properties, you can view the following Exchange server information:

Server Properties 

The information displayed in the server Properties dialog (DNS Host Name, Distinguished 
Name, Object GUID, Server Roles and Dependent Domain Controllers), will be derived from 
the initial Active Directory query (see Advanced Exchange Data Collection on page 112). If 
little or no information is displayed, it is probably a result of the required WMI permissions 
not being granted, see Required WMI Security Access Permissions on page 119.

The server properties information is cached, click Refresh Data if you want the data to be 
updated.
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The Dependant DC Tab

The Dependant domain controllers are listed with their DNS Name, and their Type. If the 
Advanced Exchange Data Collection option was checked initially, this data has already been 
collected and will display. If the option was not checked initially, selecting to view the Server 
Properties activates the collection of this data and it will display in the dialog if the 
appropriate security authorizations are set.

Type: Any of the three types of roles the domain controller can have: Authentication, Global 
Catalog or Configuration.
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Map Properties 

By right-clicking on an unused area of the grid or space off the grid, you can open the 
Exchange Messaging View menu, with the following options:

— Navigator: Allows you to view and navigate the entire grid, giving you an overview of 
what you are seeing. The blue rectangle represents the area visible in the main view.

— Clear Find: If an object on the map is in focus as a result of the right-click menu option 
Find in View, this will be enabled, and you can select to clear the find.

— View Properties: Many variables of the map view can be modified, for example colors 
of routing groups and lines, as well as line widths and styles.

For more information about the Operations Topology Viewer, see the Exchange SPI online 
Help.

If you have the Active Directory SPI installed and wish to view Active Directory detail 
using the Site Topology View, see the Active Directory SPI online Help. 

FAQs

Can I print the map image? 

No. But you can export the map, save it as .png or as a bitmap file, then open it in a graphics 
program to print the file.

How can I tell if I have WMI access to an Exchange Server?

1  Look in the <Topology Viewer install 
directory>\release\logs\AD_OvADExCollectorErrorLog.txt log file.

2  Look for a warning such as:

03/01/05 11:44:53 WARNING: Exception thrown, HR#80070005, Access is denied. 
WMI connection failed to server 'myExchangeServer01.americas.mycorp.net'. 
FileName: .\OvWmiQuery.cpp Line#128

Or

02/24/05 17:36:24 WARNING: Exception thrown, HR#80041008,  WMI connection 
failed to server 'myExchangeServer01.americas.mycorp.net'. FileName: 
.\OvWmiQuery.cpp Line#126 

What log files does Operations Topology Viewer generate?

When you launch Operations Topology Viewer, it generates OVTV_ConsoleErrorLog.txt 
and OVTV_OvADExCollectorErrorLog.txt 

files located at:

        <Topology Viewer install directory>\release\logs\

If you shut down Operations Topology Viewer, or simply cancel out, or stop then reconnect to 
a forest, the previously created OVTV_ConsoleErrorLog.txtlog file is rolled over into 
OVTV_ConsoleErrorLog.old.txt and the previously created 
OVTV_OvADExCollectorErrorLog.txt is rolled into 
OVTV_OvAdExCollectorErrorLog.old.txt.

Note that the OVTV_OvADExCollectorErrorLog.txt is created only if you receive a 
warning. If no warning occurs, then no files are created.
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Required WMI Security Access Permissions 

The following permissions are required for the Operations Topology Viewer to collect 
advanced Exchange data:

— To get Exchange server site membership data, the Operations Topology Viewer user 
must have READ and REMOTE access to the WMI namespace root\default.

— To get Exchange server DC dependency data, the Operations Topology Viewer user 
must have READ and REMOTE access to the WMI namespace 
root\MicrosoftExchangeV2.

— And to get the DNS servers of a DC, the Operations Topology Viewer user must have 
READ and REMOTE access to the WMI namespace root\CMIv2.
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A Microsoft Exchange SPI Instrumentation Files
EXSPI Exchange Discovery Instrumentation

Exchange 2007 EXSPI Instrumentation

EXSPI_CreateServices.js Discovers hosted on Services

msexchange.apm.xml Cluster support file, identifies policies 
to enable/disable

OvExchDisc.exe Discovers virtual Services

exspi_RunDiscovery.js Resource group identification for 
rediscovery after a cluster failover

HP.OV.SPI.Composer.exe Files required by the PowerShell 
Collection Configuration Utility.HP.OV.SPI.CollectionFlowPane.dll

CmdLetCommands.xml

Interop.OVPMADLib.dll

HP.OV.SPI.ExDataCollector.dll Used by the Exchange data collector. 

SNCOLLECTORKEY.SNK

SYSTEM.MANAGEMENT.AUTOMA
TION.DLL

HP.OV.SPI.ExCollectorServer.exe Used by the ExCollector server.

HP.OV.SPI.ExDataCollector.dll

SYSTEM.MANAGEMENT.AUTOMA
TION.DLL

Analyzer.dll Used by the analyzer.

AnalyzerInfo.xml

HP.OV.SPI.CollectionManager.exe Used by the Collection Manager 
service.SPIMetaData.xml

HP.OV.SPI.ExScheduler.exe Used by the scheduler.

PSCollector.dll Used by the PowerShell Collector 
service.HP.OV.SPI.ExDataCollector.tlb

CollectorInfo.xml

PSPublisher.dll Used by the data store mechanism.

PublisherInfo.xml
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xerces-c_2_7d.dll Miscellaneous files.

HP.OV.SPI.Terminator.exe

Register.bat

ex2007_*.spec Database schema definitions.
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Exchange 200X EXSPI Instrumentation

exspi_e2k.exe Collector used through schedules

exspidatasource.exe Creates database schema

EXSPI*.spec Database schema definitions

ovam*.dll Tracking log collection library

hpudm.txt Metric definitions

exspitra.vbs Turn Exchange SPI data collection 
tracing on and off

exspi_tracklog.vbs Turn Exchange tracking log file 
generation on

exspi_e2k_cfg Create mailbox

exspi_dbmount.vbs Checks mount/dismount Information 
Store

exspi_StartService.vbs Starts a service

end-to-end.xml End-to-End Config file. This file exists 
after the execution of End-to-End 
Config tool

exspi_e2k_clust_config.js For Cluster Configuration

spi_msexch*.*

shs*.*

Self healing Service support files

exspi_ports.exe Determines if SMTP, HTTP, POP3, 
and IMAP4 ports are responding

exspi_checkMemCfg.wsf

exspi_checkMemoryConfig.vbs

exspi_cMemoryConfig.vbs

Check memory settings for Exchange 
Mailbox and public Folder Servers

exspi_e2k_tlog.js

exspi_e2k_tlog.vbs

exspi_e2k_tlog.wsf

exspi_e2k_tlog_lib.vbs

Used for gathering tracking log data. 
(Average delivery time for email sent 
on current server).

exspi_cml_cfg.wsf

exspi_cmr_cfg.wsf

exspi_cms_cfg.wsf

Tools for creating Mapi client SLA 
values.

exspi_agent.vbs

exspi_core.vbs

Shared scripts with agent functions

exspi_e2k_client_lib.vbs Shared script for Client response time 
scripts
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exspi_e2k_cmr.vbs

exspi_e2k_cmr.wsf

Mapi Client Message Read response 
time scripts

exspi_e2k_send.vbs

exspi_e2k_send.wsf

Mapi Client Message Send response 
time scripts

exspi_e2k_logon.vbs

exspi_e2k_logon.wsf

Mapi Client Message Logon response 
time scripts
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B Customizing Policies
A policy is a rule or set of rules that helps you automate network and service administration. 
The Microsoft Exchange SPI provides you a range of policies to simplify your Exchange Server 
monitoring tasks. You can customize existing policies from the HPOM console.

Customize Policies Using the Tag Feature

If you have servers dedicated to specific sites or business units, you may find it effective for 
those servers to have uniquely named Microsoft Exchange SPI policies. In such cases, copy 
default policies into new groups, affix prefixes to the original names, and include them in the 
schedule policy that collects data during that measurement interval.

Task 1: Create a new Policy Group 

1 In the console tree, expand the Policy management → Policy Groups folders.

2 Right-click the folder in which you want to locate the new group, and then select New → 
Policy Group.

3 Type the new group name for the folder created, and then click Enter.

4 In the console, use Shift+click or Ctrl+click to select the default policies to be in the group, 
right-click, and then select Copy.

5 Right-click the newly created group and click Paste. The copied policy will be pasted into 
the new Policy group.

6 If you copied an entire group of default policies into the new group, you can eliminate 
those you do not need by right-clicking them and selecting Delete.

Task 2: Tag the Policies

1 Double-click each policy and make any changes to the policy desired. 

Remember to always copy scheduled task policies from the default policy group 
containing the measurement threshold policy you are copying to the new policy 
group. The scheduled task policy is necessary for any data collection to occur.
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2 Select File → Save As. In the dialog that appears enter the special prefix followed by a 
hyphen in front of the default policy name; for example Example-EXSPI-6.X IS Mailbox 
Average Delivery Time. 

3 After saving any renamed policies, double-click the scheduled task policy that you copied 
to the new group together with the other policies. (In the example, EXSPI-6.X 
Id-Dc-Instant Messaging is used.)

4 In the Command* text box at the end of the text, insert the tag (-t) parameter and the 
<prefix>- 

5 When finished, rename the scheduled task policy to include the group prefix, in this way: 

Select File → Save As and rename the EXSPI-6.X Id-Dc-Instant Messaging scheduled task 
policy to Example-EXSPI-6.X Id-Dc-Instant Messaging.

The prefix attached to the beginning of each policy in the new group makes the policies easy to 
find in the Policies grouped by type folder in the console. Also, creating a new group for the 
new policies gives you an efficient means to deploy them (right-click the group and select All 
Tasks → Deploy on...). See the Online Help for more details.
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C Service Reporter Schema
In all EXSPI Reporter database tables, the first five columns have to be ID, 
SYSTEMNAME, DATETIME, GMT, SHIFTNAME, and in that order. No EXSPI data can 
be gathered if the first five column names or their order are different from this.

EXSPI_PFSUMMARY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     ADMINGROUP
     
STORAGEGROUP_NAME
     DATABASE_NAME
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     PFLOGICALSIZE
     FOLDER_MSGCNT
     FOLDER_COUNT
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EXSPI_PFPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     PFDELIVERYTIME
     PFDELIVER
     PFSENT
     PFSUBMITTED
     PFRECIPIENT
     PFACTIVELOGON
      PFLOGON
      PFLOGONPEAK
      PFSIRATIO
      PFRECOVERITEMS
      PFRECOVERSIZE
      PFREPRCVD
      PFREPSENT
      PFREPQ

EXSPI_MBDETAIL
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     MAILBOX_NAME
     MAILBOX_SIZE
     MAILBOX_QUOTA
     MAILBOX_MSGCNT
     MAILBOX_LASTACCESS
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EXSPI_MBSUMMARY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     ADMINGROUP
     
STORAGEGROUP_NAME
     DATABASE_NAME
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     MBLOGICALSIZE
     MAILBOX_USRCNT
     MAILBOX_MSGCNT

EXSPI_MBPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCEL_NAME
     SERVER_NAME
     MBDELIVERYTIME
     MBLOCALDELIVER
     MBDELIVER
     MBSENT
     MBSUBMITTED
     MBRECIPIENT
     MBACTIVELOGON
     MBLOGON
     MBLOGONPEAK
     MBSIRATIO
     MBRECOVERITEMS
     MBRECOVERSIZE
     MBSIRATIO
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EXSPI_TRANSLOG
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INTERVAL_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     TRANSLOGFILEPATH
     TRANSLOGFILESIZE
     TRANSLOGFILEFREE
     TRANSLOGFILETOTAL

EXSPI_OMA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     OMASENT
     OMAIGNORE
     OMADISCARD
     OMARESPONSE

EXSPI_ASYNC
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     EXSPI_ASYNC
     ASYNCSENDMAIL
     ASYNCCMDS
     ASYNCCLIENTITEMS
     ASYNCSERVERITEMS
     ASYNCAD
     ASYNCCONNECT
     ASYNCPENDING
     ASYNCUSERS
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EXSPI_ASNOTIFY
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     ASNTOTAL
     ASNSENT
     ASNIGNORE
    ASNDISCARD
     ASNEXPIRED
     ASNBIFURCATED

EXSPI_SMTPPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     SMTPMSGSENT
     SMTPMSGRECEIVE
     SMTPBYTESENT
     SMTPBYTERECEIVE
     SMTPMSGBYTESENT
     
SMTPMSGBYTERECEIVE
     SMTPINBOUNDCON
     SMTPOUTBOUNDCON
     
SMTPOUTBOUNDCONREF

EXSPI_IMAP4PERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     IMAP4CON
     IMAP4FAILEDCON
     IMAP4REJECTEDCON
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EXSPI_ISPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     ISUSERCNT
     ISACTIVEUSERCNT
     ISANONUSERCNT
     
ISACTIVEANONUSERCNT
     ISCONNECTCNT
     
ISACTIVECONNECTCNT

EXSPI_MTAPERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     MTAMSGIN
     MTAMSGOUT
     MTARCPIN
     MTARCPOUT
     MTABYTESIN
     MTABYTESOUT

EXSPI_PORTS
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     PORT_NAME
     PORT_NUMBER
     SERVICE_PROVIDER
     SENT_BYTE
     RECV_BYTE
     RESP_TIME
     CONGFIG_TIMEOUT
132 Chapter C



EXSPI_MTADATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME 
     INSTANCE_NAME
     MTADATABASEPATH
     MTADATABASESIZE
     MTADATABASEFREE
     MTADATABASETOTAL
     MTADATABASEFP

EXSPI_SMTPDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     INSTANCE_NAME
     SMTPBADMAILDIR
     SMTPBADMAILSIZE
     SMTPBADMAILCNT
     SMTPBADMAILFREE
     SMTPBADMAILTOTAL
     SMTPBADMAILFP
     SMTPPICKUPDIR
     SMTPPICKUPSIZE
     SMTPPICKUPCNT
     SMTPPICKUPFREE
     SMTPPICKUPTOTAL
     SMTPPICKUPFP
     SMTPQUEUEDIR
     SMTPQUEUESIZE
     SMTPQUEUECNT
     SMTPQUEUEFREE
     SMTPQUEUETOTAL
     SMTPQUEUEFP
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EXSPI_MTLDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     MTLPATH
     MTLSIZE
     MTLCNT
     MTLFREE
     MTLTOTAL
     MTLFP

EXSPI_OWAFE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     OWACONNECTIONS
     
OWAMAXCONNECTIONS

EXSPI_OWABE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     OWAMSGSSENT
     OWAMSGSOPEN
     OWAAUTHS
     OWAAUTHSCACHE
     OWARECENTAUTHS

EXSPI_FTIDATA
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     INSTANCE_NAME
     FTILOCATION
     FTISIZE
     FTIFREE
     FTITOTAL
     FTIFP
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EXSPI_SINGLE
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     IMC_IN_MSGS_TOT
     IMC_OUT_MSGS_TOT
     IMC_TOT_IN_KB
     IMC_TOT_IN_RCPIPNTS
     
IMC_TOT_MSGS_QUEUED
     IMC_TOT_OUT_KB
     
IMC_TOT_OUT_RCPIPNTS
     IS_ACTIVE_USER_CNT
     IS_NEWS_MSGS_RECV
     IS_NEWS_MSGS_SENT
     
IS_NEWS_NNTP_POSTED
     IS_NEWS_NNTP_READ
     
IS_PRIV_AVG_DEL_TIME
     IS_PRIV_AVG_LOC_DEL
     IS_PRIV_RECV_QUEUE
     IS_PRIV_SEND_QUEUE
     IS_PUB_AVG_DEL_TIME
     IS_PUB_AVG_LOC_DEL
     IS_PUB_RECV_QUEUE
     IS_PUB_SEND_QUEUE
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     IS_USER_CNT
     VERSION
     RESERVE1
     RESERVE2
     MTA_IN_BYTES_TOT
     MTA_IN_MSGS_TOTAL
     MTA_OUT_BYTES_TOT
     
MTA_OUT_MSGS_TOTAL
     MTA_Q_LEN
     
MTA_TOT_RCPIPNTS_IN
     
MTA_TOT_RCPIPNTS_OUT
     PRIV_FREE_MB
     PRIV_IS_INST_RATIO
     PRIV_IS_LOC_DELIV
     PRIV_IS_LOG_DB_SIZE
     
PRIV_IS_MSG_RCPT_DLV
     PRIV_IS_MSGS_DELIV
     PRIV_IS_MSGS_SENT
     PRIV_IS_MSGS_SUB
     
PRIV_IS_TOTAL_MBOXES
     PRIV_IS_TOTAL_MSGS
     PUB_FREE_MB
     PUB_IS_INST_RATIO
     PUB_IS_LOG_DB_SIZE
     
PUB_IS_MSG_RCPT_DLV
     PUB_IS_MSGS_DELIV
     PUB_IS_MSGS_SENT
     PUB_IS_MSGS_SUB
     
PUB_IS_TOTAL_FOLDERS
     PUB_IS_TOTAL_MSGS

EXSPI_MULTI
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE
     INTERVAL_KEY
     METRIC_ID
     VALUE
     VALUE_ID
     SERVER_NAME

EXSPI_SINGLE
136 Chapter C



EXSPI_M0660
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     COUNTER_0660
     INSTANCE_0660
     NUM_BYTES_0660
     NUM_MSGS_0660
     SERVER_NAME

EXSPI_0661
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     COUNTER_0661
     INSTANCE_0661
     NUM_BYTES_0661
     NUM_MSGS_0661
    SERVER_NAME

EXSPI_0662
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     DEST_TYPE_0662
     INSTANCE_0662
     NUM_BYTES_0662
     NUM_MSGS_0662
     SERVER_NAME

EXSPI_0663
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SRC_TYPE_0663
     INSTANCE_0663
     NUM_BYTES_0663
     NUM_MSGS_0663
      SERVER_NAME
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EXSPI_M1002
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     FROMSYSTEM
     INSTANCEVAL
     MEASUREDTIME
     MSE_DEST_SITE
     MSE_ORIG_SITE
     PINGTIMESTAMP
     SLA
     SLAAPPROACH
     TIMEOUT
     TOSYSTEM

EXSPI_CMR
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     READSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY
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EXSPI_CML
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     LOGONSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_CMS
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     SENDSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_POP3PERF
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     POP3CON
     POP3FAILEDCON
     POP3REJECTEDCON
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Service Reporter Schema for Exchange 2007

EXSPI_DELIV
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     INSTANCE_KEY
     SERVER_NAME
     DELIVSTATUS
     SLATIME
     SLAPERCENT
     DELIVTOTAL
     PERCENTMET
     TOTALMISSEDSLA
     AVERAGEDELIV
     ORIGSVR
     INTERVAL_KEY

EXSPI_PFDETAIL
     ID
     SYSTEMNAME
     DATETIME
     GMT
     SHIFTNAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     FOLDER_NAME
     FOLDER_LASTACCESS
     FOLDER_SIZE
     FOLDER_MSGCNT

EX2007_MBDETAIL

MB_IDENTITY

MB_NAME

MB_SVRNAME

MB_SGNAME

MB_DBNAME

MB_SIZE

MB_MSGCOUNT

MB_DISCONNECT
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MB_DELCOUNT

MB_DELSIZE

MB_STGLIMIT

EX2007_MBPERF

INSTANCE_NAME

SERVER_NAME

MBDELIVERYTIME

MBLOCALDELIVER

MBDELIVER

MBSENT

MBSUBMITTED

MBRECIPIENT

MBACTIVELOGON

MBLOGON

MBLOGONPEAK

MBSIRATIO

MBRECOVERITEMS

MBRECOVERSIZE

EX2007_PFPERF

INSTANCE_NAME

SERVER_NAME

PFDELIVERYTIME

PFDELIVER

PFSENT

EX2007_MBDETAIL
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PFSUBMITTED

PFRECIPIENT

PFACTIVELOGON

PFLOGON

PFLOGONPEAK

PFSIRATIO

PFRECOVERITEMS

PFRECOVERSIZE

PFREPRCVD

PFREPSENT

PFREPQ

EX2007_IMAP4PERF

INSTANCE_NAME 

SERVER_NAME

ADMINDISPLAY_NAME

IMAP4CON

IMAP4FAILEDCON

IMAP4REJECTEDCON

EX2007_POP3PERF

INSTANCE_NAME 

SERVER_NAME

ADMINDISPLAY_NAME

EX2007_PFPERF
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POP3CON

POP3FAILEDCON

POP3REJECTEDCON

EX2007_ISPERF

ISUSERCNT

ISACTIVEUSERCNT

ISANONUSERCNT

ISACTIVEANONUSERCNT

ISCONNECTCNT

ISACTIVECONNECTCNT

EX2007_SMTPSEND

INSTANCE_NAME

SERVER_NAME

ADMINDISPLAY_NAME

SMTPMSGSENT

SMTPMSGRECEIVE

SMTPBYTESENT

SMTPBYTERECEIVE

SMTPMSGBYTESENT

SMTPMSGBYTERECEIVE

SMTPINBOUNDCON

SMTPOUTBOUNDCON

SMTPOUTBOUNDCONREF

EX2007_POP3PERF
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EX2007_SMTPRECV

INSTANCE_NAME

SERVER_NAME

ADMINDISPLAY_NAME

SMTPMSGSENT

SMTPMSGRECEIVE

SMTPBYTESENT

SMTPBYTERECEIVE

SMTPMSGBYTESENT

SMTPMSGBYTERECEIVE

SMTPINBOUNDCON

SMTPOUTBOUNDCON

SMTPOUTBOUNDCONREF
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D Embedded Performance Component (EPC) Schema
EXSPI_ASNOTIFY
     ASNTOTAL
     ASNSENT
     ASNIGNORE
     ASNDISCARD
     ASNEXPIRED
     ASNBIFURCATED

EXSPI_ASYNC
    ASYNCUSERS
     ASYNCSENDMAIL
     ASYNCCMDS
     ASYNCCLIENTITEMS
     ASYNCSERVERITEMS
     ASYNCAD
     ASYNCCONNECT
     ASYNCPENDING

EXSPI_CML
     INSTANCE_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     LOGONSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY
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EXSPI_CMR
     INSTANCE_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     READSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_CMS
    INSTANCE_KEY
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     INSTANCEVAL
     SENDSIZE
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
     RUNTIME
     INTERVAL_KEY

EXSPI_DELIV
     INSTANCE_KEY
     SERVER_NAME
     STATUS
     SLATIME
     SLAPERCENT
     DELIVTOTAL
     PERCENTMET
     TOTALMISSEDSLA
     AVERAGEDELIV
     ORIGINATING_SERVER
     INTERVAL_KEY

EXSPI_DSACCESS
    CACHEMISSESPERSEC
    CACHEHITSPERSEC
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EXSPI_FTIDATA
     SERVER_NAME
     INSTANCE_NAME
     FTILOCATION
     FTISIZ
     FTIFREE
     FTITOTAL
     FTIFP

EXSPI_IMAP4
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     IMAP4CON
     IMAP4FAILEDCON
     IMAP4REJECTEDCON
     IMAP4UID

EXSPI_ISCLIENT
     ISCLATENCY10
     ISCLATENCY5
     ISCLATENCY2
     ISCRPCATTEMPT
     ISCRPCSUCCEED
     ISCRPCFAIL
     ISCRPCFUNAV
     ISCRPCFBUSY
     ISCRPCFCANCEL
     ISCRPCFCALLFAIL
     ISCRPCFACCESSDENY
     ISCRPCFOTHER

EXSPI_ISPERF
     RPCREQUESTS
     
RPCOPERATIONSPERSEC
     ISVMLARGESTBLOCK
     ISVMLARGEFREEBB
     ISVM16MBFREE
     ISUSERCNT
     ISCONNECTCNT
     ISANONUSERCNT
     ISACTIVEUSERCNT
     
ISACTIVECONNECTCNT
     
ISACTIVEANONUSERCNT
147



EXSPI_M0660
    INSTANCE_KEY
    SERVER_NAME
    INSTANCE_0660
    NUM_BYTES_0660
    NUM_MSGS_0660
    COUNTER_0660

EXSPI_M0661
     INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0661
     NUM_BYTES_0661
     NUM_MSGS_0661
     COUNTER_0661

EXSPI_M0662
    INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0662
     NUM_BYTES_0662
     NUM_MSGS_0662
     DEST_TYPE_0662
     COUNTER_0662

EXSPI_M0663
     INSTANCE_KEY
     SERVER_NAME
     INSTANCE_0663
     NUM_BYTES_0663
     NUM_MSGS_0663
     SRC_TYPE_0663
     COUNTER_0663

EXSPI_M1002
     INSTANCE_KEY
     INTERVAL_KEY
     SERVER_NAME
     MSE_ORIG_SITE
     MSE_DEST_SITE
     PINGTIMESTAMP
     FROMSYSTEM
     TOSYSTEM
     INSTANCEVAL
     SLA
     SLAAPPROACH
     TIMEOUT
     MEASUREDTIME
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EXSPI_MBDETAIL
     INSTANCE_KEY
     INTERVAL_KEY
     MAILBOX_NAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     MAILBOX_SIZE
     MAILBOX_QUOTA
     MAILBOX_MSGCNT
     MAILBOX_LASTACCESS

EXSPI_MBPERF
      INSTANCE_NAME
      SERVER_NAME
      MBSENDQ
      MBRECEIVEQ
      MBDELIVERYTIME
      MBLOCALDELIVER
      MBDELIVER
      MBSENT
      MBSUBMITTED
      MBRECIPIENT
      MBACTIVELOGON
      MBLOGON
      MBLOGONPEAK
      MBSIRATIO
      MBRECOVERITEMS
      MBRECOVERSIZE

EXSPI_MBSUMMARY
     INSTANCE_KEY
     
STORAGEGROUP_NAME
     DATABASE_NAME
     SERVER_NAME
     ADMINGROUP
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
     EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     MBLOGICALSIZE
     MAILBOX_USRCNT
     MAILBOX_MSGCNT
     INTERVAL_KEY
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EXSPI_MTADATA
     SERVER_NAME
     INSTANCE_NAME
     MTADATABASEPATH
     MTADATABASESIZE
     MTADATABASEFREE
     MTADATABASETOTAL
     MTADATABASEFP

EXSPI_MTAPERF
     MTAWORKQ
     MTAMSGIN
     MTAMSGOUT
     MTARCPIN
     MTARCPOUT
     MTABYTESIN
     MTABYTESOUT

EXSPI_MTLDATA
     SERVER_NAME
     MTLPATH
     MTLSIZE
     MTLCNT
     MTLFREE
     MTLTOTAL
     MTLFP

EXSPI_MULTI
     INSTANCE_KEY
     SERVER_NAME
     METRIC_ID
     VALUE_ID
     INSTANCE
     VALUE
     INTERVAL_KEY

EXSPI_OMA
     OMASENT
     OMAIGNORE
     OMADISCARD
     OMARESPONSE

EXSPI_OWABE
     INSTANCE_NAME
     SERVER_NAME
     OWAMSGSSENT
     OWAMSGSOPEN
     OWAAUTHS
     OWAAUTHSCACHE
     OWARECENTAUTHS
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EXSPI_OWAFE
     INSTANCE_NAME
     OWACONNECTIONS
     
OWAMAXCONNECTIONS

EXSPI_PFDETAIL
     INSTANCE_KEY
     INTERVAL_KEY
     FOLDER_NAME
     SERVER_NAME
     
STORAGEGROUP_NAME
     DATABASE_NAME
     FOLDER_SIZE
     FOLDER_MSGCNT
     FOLDER_LASTACCESS

EXSPI_PFPERF
     INSTANCE_NAME
     SERVER_NAME
     PFSENDQ
     PFRECEIVEQ
     PFDELIVERYTIME
     PFDELIVER
     PFSENT
     PFSUBMITTED
     PFRECIPIENT
     PFACTIVELOGON
     PFLOGON
     PFLOGONPEAK
     PFSIRATIO
     PFRECOVERITEMS
     PFRECOVERSIZE
     PFREPRCVD
     PFREPSENT
     PFREPQ
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EXSPI_PFSUMMARY
     INSTANCE_KEY
     
STORAGEGROUP_NAME
     DATABASE_NAME
     SERVER_NAME
    ADMINGROUP
     EDBPATH
     STMPATH
     EDBSIZE
     STMSIZE
    EDBFREE
     STMFREE
     EDBTOTAL
     STMTOTAL
     PFLOGICALSIZE
     FOLDER_COUNT
     FOLDER_MSGCNT
     INTERVAL_KEY

EXSPI_POP3
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     POP3CONN
     POP3FAILEDCON
     POP3REJECTEDCON
     POP3DELE
     POP3RETR

EXSPI_PORTS
     SERVER_NAME
     PORT_NAME
     PORT_NUMBER
     SERVICE_PROVIDER
     SENT_BYTE
     RECV_BYTE
     RESP_TIME
     CONFIG_TIMEOUT

EXSPI_SINGLE
     Version
     Reserve 1
     Reserve 2
     IS Active User Count
     IS User Count
     MTA Inbound Msgs Tot
     MTA Outb. Msgs Tot
     MTA Tot. Recip. Inb.
     MTA Tot. Recip. Outb
     MTA Inb. Bytes Total
     MTA Out. Bytes Total
     Priv.IS Local Deliv.
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     Priv.IS Msgs Deliv.
     Priv.IS Msgs Sent
     Priv.IS Msgs Submit.
     Priv.IS Recip. Deli.
     Pub.IS Msgs Deliv.
     Pub.IS Msgs Sent
     Pub.IS Msgs Submit.
(cont.)
     Pub.IS Recip. Deliv.
     Newsfeed Msgs Sent
     Newsfeed Msgs Receiv
     NNTP Messages Read
     NNTP Messages Posted
     MTA Queue length
     Priv.IS Send Queue
     Priv.IS Recei. Queue
     Pub.IS Send Queue
     Pub.IS Recei. Queue
     Priv.IS Avg Local
     Priv.IS Avg Delivery
     Pub.IS Avg Local
     Pub.IS Avg Delivery
     IMC In Msgs Total
     IMC Out Msgs Total
     IMC Total In (KB)
     IMC Total Out (KB)
     IMC Tot. In Recip.
     IMC Tot. Out Recip.
     IMC Tot. Msgs Queued
     Priv.IS DB Size (MB)
     Priv. IS Tot. MBoxes
     Priv. IS Tot. Mesgs
     Priv. IS Log.DB Size
     Priv. IS Inst. Ratio
     Pub. IS DB Size (MB)
     Pub. IS Tot. Folders
     Pub. IS Tot. Mesgs
     Pub. IS Log. DB Size
     Pub. IS Inst. Ratio
     SERVER_NAME

EXSPI_SINGLE
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EXSPI_SMTPDATA
     SERVER_NAME
     INSTANCE_NAME
     SMTPBADMAILDIR
     SMTPBADMAILSIZE
     SMTPBADMAILCNT
     SMTPBADMAILFREE
     SMTPBADMAILTOTAL
     SMTPBADMAILFP
     SMTPPICKUPDIR
     SMTPPICKUPSIZE
     SMTPPICKUPCNT
     SMTPPICKUPFREE
     SMTPPICKUPTOTAL
     SMTPPICKUPFP
     SMTPQUEUEDIR
     SMTPQUEUESIZE
     SMTPQUEUECNT
     SMTPQUEUEFREE
     SMTPQUEUETOTAL
     SMTPQUEUEFP

EXSPI_SMTPPERF
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     SMTPMSGSENT
     SMTPMSGRECEIVE
     SMTPBYTESENT
     SMTPBYTERECEIVE
     SMTPMSGBYTESENT
     
SMTPMSGBYTERECEIVE
     SMTPINBOUNDCON
     SMTPOUTBOUNDCON
     
SMTPOUTBOUNDCONREF

EXSPI_SMTPQ
     INSTANCE_NAME
     SERVER_NAME
     ADMINDISPLAY_NAME
     REMOTERETRYQ
     REMOTEQ
     LOCALRETRYQ
     LOCALQ
     PENDINGROUTINGQ
     CATEGORIZERQ
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EXSPI_SRS
     SRSDIRPATH
     SERVER_NAME
     SSRSDIRSIZE
     SRSDIRFREE
     SRSDIRTOTAL
     SRSDIRPF
     INTERVAL_KEY

EXSPI_TRANSLOG
     
STORAGEGROUP_NAME
     SERVER_NAME
     TRANSLOGFILEPATH
     TRANSLOGFILESIZE
     TRANSLOGFILEFREE
     TRANSLOGFILETOTAL
     TRANSLOGFILEFP
     INTERVAL_KEY
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E Creating Service Accounts for Exchange 2000 
or 2003
The Microsoft Exchange SPI collects data from many sources. To collect the many types of 
data, the Microsoft Exchange SPI requires advanced user credentials. The simplest way to 
obtain these credentials is to have the HPOM management agent run as Local System. If this 
is not possible in your organization, you must create a special service account with the 
necessary privileges. 

Task 1: Create service account 

1 Log on to the system that hosts the managed node’s domain.

2 Select Start > Settings > Control Panel > Administrative Tools > Active Directory 
Users and Computers.

3 Expand the Active Directory Users and Computers and right-click Users and select New 
> User,
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4 In the New Object - User dialog, enter a user name for the new service account into the 
First Name and the User logon name fields.  

  

5 In the next window, enter Password/Confirm Password for the service account.

6 Select Password Never Expires. Then click Next.

You must create a service account with these privileges in each Windows domain. You may use any user 
name you wish. This example uses MSXSPI as the user name for the service account. 
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7 In the New Object dialog, deselect Create an Exchange mailbox, and click Next

   

8 In the next dialog, complete creating the user by clicking Finish.
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9 You are now back at the Active Directory Users and Computers dialog. In the right 
pane, right-click on the service account user just created and select Properties.

10 In the service account Properties page, select the General tab. Enter OVO Exchange 
SPI in the Display name and Description fields.

  

11 Select the Member Of tab, and click Add.

12 In the Select Group dialog select Exchange Domain Servers from the top pane. Click 
Add, then OK.

13 The new user is now a member of Domain Admins group. Click OK and exit the Active 
Directory Users and Computer dialog.
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Task 2: Add service account user to Local Administrators group

1 On each targeted Exchange 2000/2003 server, select Start > Settings > Control Panel. 

2 Double click Administrative Tools. Double click Computer Management, then open 
the Local Users and Groups folder. Select and open the Groups folder, then double 
click Administrators.

3 In the Administrators Properties dialog, click the Add button. Select the correct 
Domain from the Look in drop down list. Select the new service account user from the 
list, and click Add.

4 Update the discovery policy EXSPI-6.0 Exchange Service Discovery, to include this new 
user.

5 This procedure needs to be carried out for each targeted Exchange 2000/2003 server.  

It can sometimes take a few hours for new group membership and rights to be 
applied to a service account. 
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F Exchange Cluster Terminology
Cluster

A cluster is a group of independent computers, called nodes, that present themselves to a 
network as a highly available single system.

Node

A system that is a member of a cluster, and has a working installation of the Cluster Service. 

Resources

Resources are physical or logical entities, such as applications, or services, under the control 
of the Cluster Service.

Cluster Resource Group

A Cluster resource group is a set of resources that are grouped together to be managed as a 
single unit for configuration and recovery purposes. Each resource in a resource group may be 
dependent on other resources within that group.

A resource group is the unit of failover in a cluster. 

Failover

Failover is the process of moving a resource group from one node to another in the case of a 
failure. A failover can occur automatically, in the case of a problem, or manually, initiated by 
an administrator.

Failback

Is the process of returning a resource group to the node on which it was running before a 
failover happened.

Active/passive

A cluster is in Active/Passive mode when one node is active while another is passive/idle. Only 
when the active node fails or is taken offline, will the passive node becomes active.

Active/active

Each node is assigned some of the workload and process requests from clients. When one node 
fails or is taken offline, control of its resources are passed to the other node.

Virtual Server

A virtual server is a resource group and contains:

• A Network Name resource

• An IP Address resource

• The resources to be accessed by the clients of the virtual server.
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A virtual server acts as a standalone system. Clients on the network interact with the virtual 
server just as if it were a physical server.

Exchange Server Cluster 

To create an Exchange Server cluster, services provided by the Windows Cluster service are 
needed. Microsoft Exchange Server installs custom files and resources when installing the 
cluster-aware version of Exchange. This cluster-aware version of Exchange is installed when 
Exchange Server Setup is run on a node of a Windows Server cluster.

Exchange Virtual Server (EVS)

If Exchange is installed in a Windows Cluster; the EVS is the network name of a cluster 
resource group which contains:

• A Network Name resource

• An IP Address resource

• A Disk Resource on a common storage subsystem.

Additional resources represent the various components of Exchange:

— System Attendant

— Information Store

— Routing

— Message Tracking Agent

— MSSearch

— Protocol

— SMTP

— HTTP

— POP3

— IMAP

 The EVS runs as a unit on one node in the cluster at any given time. It may also be limited to 
a subset of the total nodes in the cluster.
164 Chapter F



G spimetadata.xml File
The spimetadata.xml file contains the information related to the collection mechanism of 
the Microsoft Exchange SPI for Microsoft Exchange Server 2007 nodes. The example below 
shows a sample spimetadata.xml file with all basic elements. You can modify the default 
spimetadata.xml file with the help of the PowerShell collection configuration utility. It is 
not recommended to modify the spimetadata.xml file manually as incorrect modification 
can lead to incorrect operation of the Microsoft Exchange SPI.

Sample spimetadata.xml File

<?xml version="1.0" encoding="utf-8"?>

<CollectionDefinitions>

  <MetricSets>

    <MetricSet>

      <Name>MetrciSet1</Name>

      <Parameters>

      </Parameters>

      <SourceDefinition>

        <Type>

        </Type>

        <Command>Get-ReplicationAge</Command>

        <DataSource>

        </DataSource>

        <DataObject>

        </DataObject>

      </SourceDefinition>

      <Metric>

        <Name>CopyQueueLength</Name>

        <Datatype>System.Int64</Datatype>

        <Description>

        </Description>

        <Type>

        </Type>
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      </Metric>

      <Metric>

        <Name>StorageGroupName</Name>

        <Datatype>System.String</Datatype>

        <Description>

        </Description>

        <Type>

        </Type>

      </Metric>

    </MetricSet>

  </MetricSets>

  <Collections>

    <Collection>

      <Name>1</Name>

      <DisplayName>New Collection</DisplayName>

      <Description>New Collection</Description>

      <Interval>00:05:00</Interval>

      <CollectionSet>

        <MetricSetNameRef>MetrciSet1</MetricSetNameRef>

      </CollectionSet>

      <Calculations />

      <Filters />

      <PublishMetrics>

        <PublishSetNameRef>Replication_Publish</PublishSetNameRef>

      </PublishMetrics>

      <AlertSets>

        <ThresholdSetNameRef>OpcMonCallForReplication</ThresholdSetNameRef>

        <AlarmSetNameRef>OpcMsgForReplicationAge</AlarmSetNameRef>

      </AlertSets>

    </Collection>

  </Collections>

<PublishedSets>

  <PublishedSet>

    <Name>Replication_Publish</Name>

    <Database>DATASOURCENAME</Database>

    <ClassName>TABLENAME</ClassName>

    <IndexBy>DAY</IndexBy>
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    <RollBy>MONTH</RollBy>

    <Capacity>720</Capacity>

    <Metrics>

      <Metric>

        <MetricRef>

          <SetNameRef>SGNAME</SetNameRef>

          <MetricNameRef>StorageGroupName</MetricNameRef>

        </MetricRef>

      </Metric>

      <Metric>

        <MetricRef>

          <SetNameRef>CPQLEN</SetNameRef>

          <MetricNameRef>CopyQueueLength</MetricNameRef>

        </MetricRef>

      </Metric>

    </Metrics>

  </PublishedSet>

 </PublishedSets>

  <AlertSets>

    <AlarmSets>

      <AlarmSet>

        <Name>OpcMsgForReplicationAge</Name>

        <Rules>

          <Rule>

            <MetricSetName>MetrciSet1</MetricSetName>

            <MetricName>CopyQueueLength</MetricName>

            <ArithmeticOperator>GreaterThan</ArithmeticOperator>

            <ValueToCompare>0</ValueToCompare>

            <LogicalOperator>LastRule</LogicalOperator>

          </Rule>

        </Rules>

        <MessageDetails>

         <Application>MyApp</Application>

          <Object>MyObj</Object>

          <Text>Sending Messge with warning as severity and  value of 
%CopyQueueLength%</Text>

          <Severity>Warning</Severity>
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          <ServiceID>

          </ServiceID>

          <MessageKey>

          </MessageKey>

        </MessageDetails>

      </AlarmSet>

    </AlarmSets>

    <ThresholdSets>

      <ThresholdSet>

        <Name>OpcMonCallForReplication</Name>

        <MetricSetName>MetrciSet1</MetricSetName>

        <MetricName>CopyQueueLength</MetricName>

        <ThresholdPolicy>Any Threshold Policy Name</ThresholdPolicy>

        <AutoBaseline IsEnable="False" />

      </ThresholdSet>

    </ThresholdSets>

  </AlertSets>

</CollectionDefinitions>

Elements of the spimetadata.xml File

The spimetadata.xml file consists of the following major elements:

MetricSets — The MetricSets element contains the following information:

• Metrics to be collected from the nodes

• Cmdlet to be used to collect the metrics

• Type of the metric data

PublishedSet —  The PublishedSet element describes the mechanism to store the metric 
data to a data store.

AlertSets — The AlertSets element contains the information on calculating the metric data 
with a threshold value and the mechanism to generate an alarm in the event of threshold 
violation.

Collections — The Collections element contains the Collection sub-element. The Collection 
sub-element holds all information on individual collection configurations. Each Collection 
element contains the following information:

• Name of the collection

• MetricSets to be used

• Mechanism to store metric data on a data store

• Mechanism to generate alarm in the event of threshold violation
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